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Wireless with Wireshark
Scanning wireless to find devices

with Wireshark
Megumi Takeshita, Packet Otaku

Ikeriri network service

please download the trace files and scripts at 
https://www.ikeriri.ne.jp/sharkfest/ikeriri25eu.zip
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Megumi Takeshita, Packet Otaku, ikeriri network service

sample traces and configurations are 
https://www.ikeriri.ne.jp/sharkfest/ikeriri25.zip 2

• Worked SE/IS at BayNetwork, Nortel
• Reseller of CACE technologies in 2008
• Founder, ikeriri network service co., ltd

Reseller of packet capture / wireless-tools
• Wrote 10+ books about Wireshark in Japanese
• Instruct Wireshark to JSDF etc.
• Lecturer of CHUO University 
• One of the contributors to Wireshark

Translate Wireshark into Japanese
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Session Overview

Wireshark is a tool for analyzing both wireless and 
wired networks. In this session, Megumi will show 
you how to find devices on your wireless network. 
With various scanning tools, we can explore 
different standards of WiFi networks and Bluetooth 
using Wireshark. Additionally, tshark and other 
Wireshark command-line interface (CLI) tools are 
helpful in collecting and summarize device 
information. Use Wireshark to manage your 
wireless environment and enhance your
security!! 3
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Customize Wireshark for Wireless
Set Aliases, Columns, Display Filter buttons, Coloring Rules
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Wireless with Wireshark

• Open trace file wifi7.pcapng

• It is the typical wifi7 connection sequence between Buffalo AP 
and iphone16 Pro STA

• Let’s start Wireless analysis with Wireshark
No. 

1 
2 

3 

4 

5 

6 

7 

8 

9 

Time Source Desti Protoco Length Info 
0.000000 Buffalo 45 :1.. Bro.. 802.11 509 Beacon fra""', SN=2986, FN=0, Flags= . ..... . . , BI=100, SSID="ik.,riri7" 
0 .00824 7 22 :de: 13 :07: ... Br o ... 802. 11 
0 . 009414 Buff a l o_4 5: 1... Br o ... 802 . 11 
0 .136344 22 :de: 13 :07 : ... Bu f... 802 . 11 

0 . 136360 22: ... 802 . 11 
0 . 136367 

0 . 136374 
0 . 138331 

0 . 138341 

Buff a l o_4 5: L.. 22: ... 802. 11 

Bu f... 802 . 11 
22 : de: 13 :0 7: ... Bu f... 802 . 11 

22: .. 802. 11 

183 Pro be Reque s t , SN=1794 , FN=0, Fl ags = . .. ... .. , SSID=" i ke r i r i 7" 
4 87 Pro be Re s ponse, SN=2987 , FN=0 , Flags = . . . . .. . . , BI= 100 , SSI D="iker i r i 7" 

75 Aut henti catio n, SN=1798 , FN=0, Flags = . . ..... . 
42 Acknowl edgeme nt, Fl ags = . ... . .. . 
62 Aut henticatio n, SN=19 , FN=0 , Flags = ....... . 
4 2 Ac knowl edgement, Fl ags = .. .... . . 

247 Asso ciatio n Reques t , SN=1799, FN=0 , Flags = ... . . . .. , SSID="ike r i r i7 " 

4 2 Ac knowl edgement , Fl ags =, , , , , , , , 

320 Asso ciatio n Response , SN=20, FN=0 , Flags = . ... ... . 
42 Acknowl edgeme nt, Fl ags =. , .... . , 

10 0 . 163541 Buff a l o_4 5: L.. 22: ... 802 . 11 

11 0 . 163562 Bu f .. 802 . 11 
12 0 . 177520 Buff a l o_4 5: 1... 22: ... 802 . 11 
13 0 . 177978 22 : de: 13 :07 : ... Bu f... 802 . 11 

14 0 .177990 Buff a l o_4 5: 1... 22: ... EAPOL 

53 VHT/ HE/ EHT/ RANGI NG NDP Announ cement, Sound i ng Di a l og To ken=ll , Fla gs= ... ... . . 

1 5 

16 

17 
18 

19 
20 

21 
22 
23 

24 
25 

26 

0. 177996 Bu f... 802 . 11 
0 . 179295 22 : de: 13 :07 : ... Bu f... EAPOL 

0 . 179302 22 : .. 802 . 11 
0 . 183007 

0 . 183014 

Buff a l o_4 5: L. 22: ... EAPOL 

Bu f .. 802 , 11 
0 . 183962 22 : de: 13 :07 : ... Bu f... EAPOL 

0 . 183969 22 : "' 802 . 11 
0 . 1850 16 22 : de: 13 :0 7: ... Bu f... 802. 11 
0 . 193412 Buff a l o 45: 1... Bro ... 80 2 .11 

0 . 1934 23 Buffa l o_4 5: 1... Br o ... 802 . 11 
0 . 1934 30 Buff a l o_ 4 5: L.. Br o ... 802 . 11 

0 .204750 Buff a l o_4 5: 1... Br o ... 802. 11 

4 65 Actio n No Ac k, SN=2 , FN=0 , Fl ags = .. , .... . 

187 Key (Messa ge 1 o f 4 ) 
4 2 Acknowl edgement, Fl ags = . .... , . . 

208 Key (Message 2 o f 4 ) 

4 2 Ac knowl edgement, Fl ags = ....... . 
253 Ke y (Message 3 o f 4 ) 
4 2 Ac knowl edgement , Fl ags = , , , , , , , , 

165 Ke y (Message 4 o f 4 ) 
4 2 Ac knowl edgement, Fl ags = . . .... . . 

85 Actio n , SN=1801 , FN=0 , Fl ags =. p . . ... . 
108 [Data, SN=4071, FN=0, Fl ags=. p . .. . F. 
108 Data, SN=4072 , FN=0 , Fl ags =.p .... F . 
108 Data, SN=4073, FN=0 , Flags=.p ... . F. 
50 9 Bea co n f rame , SN=2992 , FN=0 , Fla gs = . . .. . . .. , 8! =100 , SSID="i ke r i r i 7" 

Fr ame 23 : Pa cket, 108 byt es o n wi re ( 864 bits ) , 108 byte s captu r ed ( 864 bits) o n i nte r face unknown, i d 0 0000 

Rad i o t ap Heade r v0, Length 32 0010 

80 2 . 11 rad i o i nformati on 0020 

IEE E 802 .11 Data, Fl ags : . p ... . F . 
0030 
0040 

Data (44 bytes ) 0050 
0060 

00 00 20 00 6f 00 04 00 
00 0 c 4 7 18 00 00 c 3 a 7 
0 8 4 2 24 00 f f ff ff ff 
84 e 8 c b 45 l d a0 70 f e 
4 c ee ee 40 b2 b7 66 84 
e7 as bb 32 l a ef 62 40 
d7 d9 f 4 b4 35 63 4 8 c8 

Sharkliest'25 c~ 
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a9 a 7 Ba 03 7c 24 06 00 
00 00 00 00 4 7 18 35 00 
ff ff 84 e8 c b 4 5 l d b8 
08 02 00 60 00 00 00 00 
12 b2 d6 2a 35 69 9b df 
e9 al d2 91 be 27 88 c d 
af 38 95 85 
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Add alias name on ethers 

In wireless analysis, you need to work with MAC addresses rather 
than IP addresses.

Adding an alias to the ethers file in your profile is essential.

Aliases help you easily identify your known Aps and STAs.

Edit ethers on your Wireshark
profile directory
Help>About Wireshark
Select the Folders tab and 
look for personal configuration

We can use alias names in 
display filter, Endpoints,
Conversations, I/O Graph,
Flow diagram and so on

No. Time Souroe 

:1 : 0i . 000000, 13uf fa l oAP 
2 0 . 100i8247 iPhoneSTA 
3 0 . i00r9414 13uffa loAP 
4 0 . 136344 i PhoneSTA 
5 0 . 136360, 

6 0 . 136367 13uf f aloAP 
7 0 . 136374 
8 0 . 138331 i PhoneSTA 
9 0 . 138341 
10 0 . 163541 13uffa loAP 
11 ,n _ 1 i;:p;i;:;i 

13 ~oadcast 80,2 .11 

Broadcast 80 2 . 11 
Broadcast 802 . 11 
13uf faloAP 80 2 . 11 
iPhoneSTA 802 . 11 
iPhoneSTA 80 2 . 11 
Buffa loAP 802 . 11 
13 uf faloAP 802 . 11 
iPhoneSTA 802 . 11 
iPhoneSTA 802 . 11 
R11 ffa foAP 80J _ 11 

Sharkliest'25 c~ 
EU~PE ~ 
~ M1 ~ ~ 

,U~ 

Le ngth Info 

50r9 13eacon f r ame, SN=2986, 
183 Probe Request J· SN=l 79-4 
487 Probe Response J• SN=298 

75 Authentication, SN=179 
42 Ackn md edgement.,. Flags 
62 Authentication, SN=19 , 
42 Ackn md edgement .,. Flags 

247 Association Request.,. S 
42 Ackn md edgement J• Flags 

320 Association Response .,. 
4J A,kn nw1 PrlPPmPnT . ~l ~P~ 
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Add columns on Packet List

• Add columns to your Packet List

• You can drag and drop the field
into Column tabs directly, or 
select Edit > Preferences > 
Appearance > Columns

• Add columns for WiFi analysis.
Recommended fields are
PHY type, CH, Freq, Signal, MCS, 
Rate, Retry, Type/Subtype, STA, 
BSSID and SSID

• We do not need the Packet length, 
so check out the Displayed
checkbox

Sharkliest'25 c~ 
EU~PE ~ 
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Time PHY type CH .. I I .. MCS Rate Retry Type/ Subtype Source Destination SS ID BSSID STA Length Info 

11 10 . 000000 802.lla (OFD .. 53 6215M.. -62 d.. 6 Beacon f rame Buffalo_45:- Broadcast "i keri- Buffalo_45:ld:_ 509 Beacon f rame, S 
2 

3 

0.008247 80 2 . 11a (OFD.. 53 621 5M . . -58 cL 

0. 009414 802. lla ( OFD... 53 6215M... -62 d ... 

Displaryed J i I e 

Na. 

Jype 

Nlll her 

J i e ( ' ■ 

■ 

■ 

■ 

J i e 

p y .pe 

C 

F~BqJ. 

Si.gnal 

MCS 
Ra e 

P!! ry 

LJI ' ' 0 

tll Q 

LII S 0 

Lil · . 0 

Lil . 0 

tll . 0 

as spec1 ed 

Jype/Su btype Clll . o 

SoL11 rce So L11 rce add l'iess 

Des ina ion D . ina ion addrcess 

Leng .h Pack Ieng h (h1 es} 

SJ w Q 

BSS~D Lil 0 

SSID U · 0 

In In or 10n 

6 

6 

Probe Reque .. , 22: cle: 1 3 : 07 ... Broa,dcast 

Pr obe Res po- Buffalo 45: _ Br oadcast 

Cu s o Expression 

lan_rad i . phy 

. lan_rad i o.c han n el 

lan_rad i a. ~eq Lil ency 

rad io. p.db _an sig nal 

rad io ap. cs.indeJi: 

rad io. ap.dla ara. e 

Ian. c . l'i ry.a pe 

. Ian, c . pe_.sru b pe 

Ian .. aa 

lan.hssi,d 

w lan.ssid 

" i keri... Buf fa l o 45 : 1 d : ... 

"ikeri... Buffalo 4 5 : ld: ... 

183 Probe Request, 

4 87 Pr obe Res po nse , 
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IEEE802.11 frame type/subtype

Type Type and Subtype

Management
wlan.fc.type==0

Used by 
manage
ment of 
WiFi
network

Beacon wlan.fc.type_subtype==8

Probe Request wlan.fc.type_subtype==4

Probe Response wlan.fc.type_subtype==5

Authentication wlan.fc.type_subtype==11

Deauthentication wlan.fc.type_subtype==12

Association Request wlan.fc.type_subtype==0

Asociation Response wlan.fc.type_subtype==1

Disassociation wlan.fc.type_subtype==10

Action wlan.fc.type_subtype==13

Control
wlan.fc.type==1

Used by 
control 
of data 
commu
nication

RTS (Request To Send) wlan.fc.type_subtype==27

CTS (Clear To Send) wlan.fc.type_subtype==28

ACK (ACKnowledge) wlan.fc.type_subtype==29

BAR (Block ACK Request) wlan.fc.type_subtype==24

BA(Block ACK) wlan.fc.type_subtype==25

Data
wlan.fc.type==2

Data(with ACK) wlan.fc.type_subtype==20
Null Data(No data) wlan.fc.type_subtype==36
QoS Data(with BlockACK) wlan.fc.type_subtype==40

• First, we need 
to know frame 
types and 
subtypes of 
the IEEE802.11 
frame

• Here are the 
common types 
and subtypes 
of WiFi.
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Add Filter Buttons

• Choose Edit -> Preference,
select Appearance -> Filter 
Buttons.

• Create Parent Item // 
Children Items and set Filter 
Expression on each Items

• You can filter multiple WiFi
type/subtypes like 
wlan.fc.type_subtype in { 4,5 }

• The filter button helps you to distinguish frames and understand 
the WiFi sequence easily

Wi reshark , Preferences 

v Appearance 

Columns 

Font and Col ors 

Layout 

Cap re 

Expert 

I Filter Bu ons 

Name Re.solut ion 

> Protocols 

RSA Keys 

> Sta -s -cs 

Advanaed 

Show in ool bar 

• • • 
• • 
• • 
• 
• • • 

Button L.abe!I 

Ma riagemeint/ / All 
Ma riagement/ / Beacon 

Ma riagemeint// Probe Request 

Ma nageme nt// Probe Respo:nses 

Marnagement// Probe Req and Ir.es 

Marnagement// A en icat io rn 

Ma riagement// Association Requests 

Fillter Expression 

w lan.fc.type = =0 

w lall'l.fc.typ e_siubtype == 8 

wilarn.fc.type_siubtype = = 4 

wilall'l,fc.typ e_siubtype = = 5 

wilall'l.fc.typ e_siubtype in [4.5} 

wila1rn.fc.typ e_siubtype = = 11 

wilan.fc.typ e_siuhtype = = 0 

Management// Association Responses w lall'l,fc.type_siuhtype == 1 

Marnagement// Associa ion, eq and Res w lall'l.fc.typ e_siuhtype in (0, 1} 

MarnagemenV/ Disassociat ion w la1rn. c.typ e_siuhtype = = 10 

Ma riagement/ / Deauthenticah o n 

Marnagement// Disassoc and Deauth 

Ma rnagement/ / Action 

Con rol Frames// A l I 

Control Frames// ACK 

Control Frames// RTS. and CTS 

Control Frames/ / BAR and BA 

Dat:a/ /A!II 

Dat:a//N ulll Data 

Dat:a//QoS Data 

w lan.fc.type_siuhtype == 12 

w lall'l,fc.typ e_siuhti; pe in {1 0, 12} 

w lall'l.fc.typ e_siuhti; pe ==13 

w larn. c.typ e == 1 

w lan.fc.type_siubtype = = 29 

w lall'l,fc.ti; pe_siubtype in {27,28} 

wilall'l.fc.typ e_siubtype in [24,25} 

wilarn.fc.typ e = =2 

wilall'l,fc.type_siubtype = =3.6 

wilarn. c.type_siuhtype = =40 

Sharkliest'25 c~ 
EU~PE ~ 
~ M1 ~ ~ 
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Add coloring Rules for WiFi analysis

• View>Coloring Rules

• Set different colors by frame types 
and subtype
Beacon, Probe Request Probe 
Authentication, Deauthentication, 
Association Request, Association 
Response, Disassociate, Action, 
ACKnoledgement, Block ACK, Block 
ACK Request, RTS, CTS, EAPOL, Data, 
QoS Data and Null Data

• It helps to understand the sequence 
of the WiFi connection easily

!Vires a k , . olori g 

Na e 

■ Beaco n 

Pro e Request 

be es.ponse 

les Defau 

Fi~ter 

w lan. c.type_subtype = = 8 

wla .fc.type_subtype = = 4 
Ian. c:.type_subtype = = 5 

II Association Requ w lan. c.type_subtype = = 0 

II Associa • o Response w la n. c. pe_su b pe = = 1 
...,,., Disassociate "1.1\1an.fc.type_subtyrpe = = 110 

1 ,...,. Action wtan.fc.type_: s.ubtype =·= 11:3 

Sharkliest'25 c~ 
EU~PE ~ 
~ M1 ~ ~ 

,U~ 
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Add coloring Rules for WiFi analysis

• Check on Colorize button and Statistics -> Flow Graph

No. Time PHYtype CH Ffeq. Signal MCS Rate Retiy Type/Subtype Destination SSID Info 
1[0. 900000 802 . lla (Of DH) 53 621Slt-!z -62 dB• 

2 0 . 008247 8'l2 . 1h (Of c»-1) 53 621Stflz -58 dB■ 
3 0 . 009414 802.lla (OFDN) 53 621Sl-11z -62 dB■ 

4 0 .136344 802. lla (OFCN) 53 621Sl-l-iz -59 dB■ 
21s..lZ-l'i'lillllli 

6 0 .136367 802. l b (OFCN) 53 621Sl-l-iz -61 dB■ 

7 0 .136374 802.1111 (OfDH ) 53 621Sl-f-lz -59 dB■ 

B 0. 138331 802.1111 (OFDN) -58 dB■ 
9 0 .138341 802.1111 (Of DM) -61 dB■ 

10 0 . 163541 802.1111 (Of DH) 53 6215HHZ ·61 dB■ 

11 0 .163562 802.1111 (OFON) 53 621Sl1-iz -58 dB■ 

12 0. 177520 802.1111 (Of i:»1) 53 621Sl-liz -73 dB■ 

53 621Sl-11z -58 dB■ 

14 0 .177990 802. lla (OFCN) 53 621Sl-l-iz -60 dB■ 

15 0. 177996 802.lla (OFOM) -59 dB■ 
16 0 .179295 802. lla (OFCN) 53 62151-1-iz -58 dB■ 

17 0 .179302 802.lla (Of°" ) -61 dB■ 

18 0. 183007 802. lla (Of °") -60 dB■ 
19 0 .183014 802.11a (Of °") -58 dB■ 

20 0 .183962 802. lla (Of °") 53 6215HHZ -59 dB■ 
21 0 .183969 B02.1111 (OF°") 53 621511-iz -61 dB■ 

22 0 .185016 802. lla (Of °") 53 6215HHZ -59 dB■ 

23 0 . 193412 B02. lla (OF°") 53 621511-iz -61 dB• 
24 0. 193423 802. lla (Of °") 53 62151+iz -61 dB■ 

25 0 .193430 802. lla (Of °") 53 62151-1-iz -61 dB• 
26 0 . 204750 802.lla (Of °") -61 dB■ 

Beaconfraae 
Probe Requ .. s t 

Probe Response 
Authentication 

Acknowl £.dP.!!:nt 
Authentication 

Acknowledg .. 111<!:nt 

BuffaloAP 
iPhoneSTA 

BuffaloAP 
i Phone5TA 

BuffaloAP 

Association Reques t iPhoneSTA 
Acknowledgelll<!:n t 

Association Response BuffaloAP 

Broadcast ~ikeririrBuf faloAP 
Broadcast ~ikeririrBuffal oAP 
Broadcast ~ikeririrBuffal oAP 

BuffaloAP Buffa l oAP .....,.,. 
iPhone5TA 

BuffaloAP 

BuffaloAP 

BuffaloAP · ikeririr Buffa l oAP 

iPhone5TA 

iPhoneSTA 

Beacon fr1111e, SN•2986, f Ns0, flags• . . . . . . . , BlslOO, S~ 

Probe Request , SN• l794, FN•0, Flags • . . . . . . . , SSIO• " i k, 

ProbeResponse,SN•29B7,fN•0, flags• . . ..... ,81• 100, 
Authentication, SN•179B, FN•0, Flags• . . 

Ad:now ~ nt ~ lj111s• .. 
Authentication,SN•19,FN•0,Flags• .. . 

Acknowledge.ent, fhgs • .. 
Assoc iation Request, 5N•t799, FN•0, Flags• .... . . . , ss: 
Acknowl .. dge.ent, Fhgs• . . 

Acknowledgelll<!:nt BuffaloAP 

VttT/HE/EHT/RANGI NG - Buffal o_45: t d:b8 1Phone5TA 

Assoc iation Response , SN•20, FN•0, Flags• .. 
Acknowledgeaent, Flags• . . 

VHT/ HE/fHT/RANG HIG MJP Announc""°nt, Sounding Dialog Tc 

Action No Ack 
Qo5Oata 

Acknowhdgelll<!:nt 
QoSOata 

Acknowledg .. 111<!:nt 
QoS Data 

Acknowledgelll<!:n t 
Qo5Data 

Acknowledgelll<!:nt 

Action 

Oata 

Oata 
Beacon frame 

iPhoneSTA 
BuffaloAP 

BuffaloAP 

BuffaloAP 
iPhone5TA 

BuffaloAP 
BuffaloAP 

i PhoneSTA 

iPhoneSTA 
BuffaloAP 

BuffaloAP 
iPhoneSTA 

BuffaloAP 
Buffalo_45: l d:a0Broadcast 

Buffalo_45: 1d:a0Broadcast 
Buffalo_45: l d:a0Broadcast 

Buffa l oAP Action No Ack, SN•2, FN•0, Fhgs• . .. 
Buffa l oAPiPhone5TAKey(Hessag .. lof4) 

Acknowledge-nt, Flags• .. 
Buffa l oAP iPhoneSTA Key (Message 2 of 4 ) 

Acknowledge-nt, Fhgs• .. 
Buffa l oAP iPhoneSTA Key (Message 3 of 4 ) 

Acknowl .. dge.ent, Fhgs• . . 
Buffa l oAP iPhoneSTA Key (Message 4 of 4 ) 

Acknowledgeaent, Flags• . . 

Buffa l oAP Action, stl•1801 , FN•0, Flags•.p., 
Buffal oAP Broadcast Data, 5N• 4071 , fN•0, Flags• . p 

Buffa l oAP Broadcast Data, SN•4072, fN•0, Flags• . p 
Buffa l oAP Broadcast Data, SH• 4073, fN •0, Flags• . p. 

Bea con frame, SN• 2992, fN• 0, fl ags• . . . , . , ., Bl•lOO, S! 

Wireshark • Flow • wifi7.pcapng 

Time 
BuffaloAP iPhoneSTA 

Broadcast 

0.000000 

0.008247 

0.009414 

0.136344 

0.136367 

0.138331 

0.1 63541 

0.177520 

0.177978 

0.177990 

0.179295 

0.183007 

0.183962 

0.185016 

[Beacon frame, SN =2986. FN =O, Flags=- - -¥ 81=100, ss1.1! : 
I b:ooe Request SN=1 794. FN=O. Flaps=- SSID=· ilcer .. ~ 

rrobe Response. 5N =2987, FN=O, Flags c:c 

Association Respon,e, l a20, FNaO, Flag 

I ~ •• Action No Ack. SNT FNc:cO, Flagsc:c .... 

1 of4) 

2of4) 

3of4) 

4 of4) 

0.193412 I 
0.193423 ! 

o.193430 l : 

Buffalo_45: 1d:b8 

! 

i 
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No. Time PHV type CH Freq. Signal MCS Rate Retiy lype/Subtype Destination SSID BSSID Info 

1 0.900089 882.11a {Oftf'I) 53 621'5Pliz -62 d8II 6 Bucon r1111e BuffaoN' 

- TA 
BuffaloAP 

Broadcast lkedrl7 Buf a l oAP 
lrollckast: • l U r l rl7• luff• l oAP 
Broadcast " ik .. riri7"BuffaloAP 

Beacon .--, SN-2986, FN-9, F ags- •••••••• , 81-190, :1 2 9.881247 N 2 . 11• (Ofllfl) SJ 621Mb: •SI .. Probe hquest: Probe hquest , Sft,,1794, ,..., flap• . .. . . . . . , s sm-• l 

5 0.136360 802 . 11a {OHIH) 53 6215MHz -61 dB■ 

7 0.136374 802 . 11a {OFDH ) 53 6215MHz -59 dBa 
lll .138331802. 111 { 0FOPI 5J6215'9fz -Sllm. 

9 0.138341 B02 . 11a {OFDH) 53 6215/'tiz ·61 dBa 

10 0. 163541 1182 . lla (OFOPI ) 'B 6215/'tiz -61 dBII 
11 0. 163S62 802.lla {OFOH) 53 621511Hz -SB dBa 

12 0. 177520 B02 . 1la {OFDH ) 53 621511-iz -73 dBa 
53621 51-tiz -SBdB■ 

1 8 .177996 882. 11• OfDf'I 53 6l1Sftfz ·68 
15 0.177996 802.lta {OFDH) 53 62151-tiz -59 dBa 

' 16 . }?9Z9 ~2_ . 1 QFtJl'I ' 'i'f 62_15"1~ ·'Hf 

17 0.179302 802.lta {OFDH) 53 62151-tiz -61 dBa 

18 0. 183807 882 .lta OFDH) 53 621511-iz -6e de■ 
19 0.183014 802.lta {OFOH) 53 62151-tiz -SB dBa 

2ee.te!%2 se2 .11a OFOM s, 6 21 5Niz -59 cftla 
21 0.183969 802.lla {OFOH) 

230 . 193412802.lla(Of DH) ·61dBm 
24 0 .193423 802.lla (OFDH) 53 6215/'tiz -61 dB■ 
25 0 . 193430 B02 . lh (Of DH) 53 6215MH~ -61 dBm 

26 8.204750 802 .lla {OF°") 53 6215'<91z -61 dB■ 

iPhoneSTA 

" • 

Prob .. R .. spons .. ... -- "" "' -Acknowledg .. .,..nt 

Acknowl .. dg .. .,..n t 

Associat on Reques t Phone5TA 
Acknowl .. dg .. .,..nt 

Association Response BuffaloAP 
Acknowledg .. ent 

_,...m _,...m 

Buffal oAP 
Buf fa l oAP • uerirt?• 8uff11l oAP 

iPhon .. STA 

1Phone5TA 

BuffaloAP 

BuffaloAP 

Prob .. R .. spons .. , SN• 2987, fN •0, Flags • . . . . . ... , Bl • lOO, ""' .. _ ...__.,,,,. .... 
Acknowl .. dg .. ..,nt , Fhgs• . . 

Acknowl .. dg ..... nt , Flags• . . 

Associat Oft Request ,. SN•1799, f N .. ,. fl~• ... .. . ·~ ~ 
Acknowl .. dge ... nt , Flags• . .. 

Association Response, 5N•20, FN~, Flags• . . 

Acknowledge ... nt, flags• . . 
vtfT/HE/fHT/RANGHIG _ Buffalo_45 : 1d : b8 iPhon .. STA VHT/HE/EHT/RANGING MlP Announc .. 11ent , Sounding Dialog l< 

Action No Ack 
QoS 0.t. 
Acknowledgeent ~, 
Acknowledg .. -nt 

QoSOata 
Acknowledg .. -nt 

QoSDllta 
Acknowledg .. ent 

8eaconfraae 

iPhoneSTA 

Buf . o/11. 

8uffal oAP 

iPhoneSTA 

BuffaloAP 

il'hon.-ST 
BuffaloAP 

· ~ ff 

iPhone5TA 

BuffaloAP 
Buffa l oAP 

iPhoneSTA 

BuffaloAP Action No Ack , SN•2, H1•0, Flags• .. 

Buf al~ iPhoneSTA t:: .. y~ Pku11ge 1 o 4 
Acknowledge•ent, Flags• . . 

TA r- · 1"e f 4 

BuffaloAP iPhone5TA K .. )'. (Hes s age 3 of 4 

Acknowledge ... nt, flags• . . 
Buffa l oAP i PhoneSTA J:'.ey (J11ts sa1e 4 of 4 ) 

Acknowledge ... nt , flags • . . 

Buff a lo_45:ld:a0Broadc ast BuffaloA?BroadcastData, SN•4071 , FN•0, Flags•.p j 
Buffalo_45: l d:a0 Broadcast BuffaloAP Broadcast Data, SN• 4072, FN•0, Flags•.p 

Buff a lo_45 : ld:a0 Broadc as t BuffaloA? Broadcast Data, SN•4073 , FN•0, Flags• . p 
8ufh,loAP 8ra.dcast "ikeririr BuffaloAP Beacon fr-■e Stt-2992, FN--0 Fl~- ....... , 81•180, 

D X 

Buffalo_45:1d:a0 
Comment 

Beacon frame, SN:2986, FN=O, Flags= ......... BI:100, SSIDc:c "ike 

Probe Request 5Nc:c1794, FN=O, Flagsc:c _ ...... 551Dc:c "ikefiri7" 

Probe Response, 5N=2987, FNc:cO, Flags= ......... Blc:c100, SSIDc:c "i 

Authentication. SN=1798. FN=O, Flags= 

Authentication. 5Nc:c19. FN:O, Flags= .... 

Association Request. SN=1799, FN=O, Flags= ....... SSIDc:c · ikeri. 

Association Response. 5Nc:c20, FNc:cO, Flags= ...... . 

WHT/HE/EHT/RANGING NOP Announcement Sounding. VHT/HE/EHT/RANGING NOP Announcement Sounding Dialo. 

Data. SN 4071 . ~N 0, Fla s .p .... F. 

' ' Data, SN =4072, ~N =O, Flags .p .... F. 

' ' Data. SN c:c4073. ~Nc:cO, Fla sc:c.p .... F. 

Action No Ack. SN=2. FN=O, Flagsc:c ..... . 

Key (Message 1 of 4) 

Key (Message 2 of 4) 

Key (Message 3 of 4) 

Key (Message 4 of 4) 

Action. 5N =1801. FN =O, Flagsc:c .p .... 

Data. SN=4071, FN c:cO, Flags=.p .... F. 

Data. SNc:c 4072. FN =0, Flagsc:c .p .... F. 

Data. SN=4073, FN c:cO, Flags=.p .... F. 

0.204750 L-------J;'lleaco;;;;;;;";;";;' ;;me;;,;;SN;;•;;299;;;;;2.;;FN;;•;;O;;, F;;lag:;s;;•;;··;;-•;;B;;l•;;lOO;;;;;, S;;SI:·•:.' -------------..l--------------.l..-------------..l..--------------1-----...J Beacon frame, SN=2992. FN=O, Flags=···-- B1=100, 551D= "ike 
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Copy the profile into your environment

• Help -> About Wireshark -> 
Folders to find your personal 
configuration location

• Copy WiFi folder ( extract from 
WiFi.zip ) into your profile 
directory (for example, copy into 
C:¥Users¥username¥AppData¥R
oaming¥Wireshark¥profiles if 
you use Wireshark in Windows)

• Change your Wireshark profile,
click the right bottom Profile 
button and change it from 
Default to WiFi

About Wireshark 

Wireshark Aut hors 

Search Folders 

Name 

"Fil e" ,dialog locat ion 

Global Extcap pat h 

Global Lua Plug ins 

Global Plugins 

Glob;i,I configurat ion 

MaxM ind DB pat h 

MaxM ind DB pat h 

MaxM ind DB pat h 

Personal Extcap pat h 

Personal Lua Plugins 

Personal Plug ins 

Fold ers Plug ins Kei1board Shortcut s Acknow ledgmen s License 

Locat ion Typical Fil es 

C:¥Users¥megumi¥On eDrive - .. ,shark-Seminar¥Wireshark-9¥ Cilpture files 

C:¥Program Fil es¥Wireshark¥e;,:tcap Ext ernal capture (e;,:tcap) plug ins 

C:¥Program Fil es¥Wireshark¥plugin s 

C: ¥Program Fi I es¥Wi resh ark¥pl ug in s¥4, 6 

C:¥Program Fil es¥Wireshark 

C: ¥P rog ramDat a¥Geol P 

C:¥GeolP 

C: ¥Users¥meg u mi¥AppDat a¥Roami n g ¥Wi reshark¥Geol P 

C: ¥Users¥meg u mi¥AppDat a¥Roami n g ¥Wi reshark¥e;,:tc ap 

C:¥Users¥megumi¥AppDat a¥Roaming¥Wireshark¥plugins 

C:¥Users¥megumi¥AppDat a¥R ... ing¥Wireshark¥plugin s¥4.6 

Lua sc ript s 

Binary plug ins 

Pref erences, profi les, manu~ .. . 

MaxM ind DB •database search pat h 

MaxM ind DB d at abase search pat h 

MllJ< M ind DB d at abase search pat h 

Ext ernal cap ure (e;,:tcap) plug ins 

Lua sc ri pt s 

Binary plug ins 

Personal config urat ion C: ¥Users¥megu mi¥AppDat a¥Roami n g ¥Wi resh ark Preferences, profi les, m;in u~ .. , 

Program files Pr,ogram 

System 

Temp 

C:¥Program Fil es¥Wireshark 

C:¥Program Fil es¥Wireshark 

C: ¥Users¥megu mi¥AppData¥Local ¥Temp 

ethers, ipxnets 

Unt it led capt ure fi les 

C ( :¥Users ¥ ·· eg L1 mi¥AppData¥Roa • i11g ¥Wireshark¥profilesl 

c..,n rn 

Wilri 2025/10/28 9:09 

Sharkliest'25 c~ 
EU~PE ~ 
~ M1 ~ ~ 
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Basic Connection sequence
Beacons, Probes, Authentications, Associations and 4-way Handshake
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Basic Connection sequence

• APs send Beacons periodically ( every 100ms in usual )

• STA sends Probe Requests to determine the best AP, AP sends 
back Probe Response including AP specifications.

• STA and AP exchange Authentication frames ( WPA2: Basic 
Authentication, WPA3: Simultaneous Authentication  of Equals )

• STA sends Association Request and AP sends back Association 
Response to negotiate exchange Association frames, including 
the actual connection settings between STA and AP

• STA and AP start EAPOL 4-way handshake to create PTK for 
unicast, AP sends GTK for multicast, broadcast.

Comment 

r----i ~:;;.;,~~~~~~!!iB}i,oo~d~,_" _' ________ .,J,.. ________ '::"::"'::'0~':' ::'d::M:.... _______ +--------~' :"•:,1:o-:45:,1:d:a~O--• 
0.000000 tramio. SNz2986, FN=O. Fla.Qsa .• 6/alOO, SSI .. 1 - , 

L 
0.008247 ;:;:~r :;!!!:~!!!SN!!•'!!!"'!.!'"!!!•:!!.•-!!!Jl!!~S=.~-~- =·t' ---------+---------~l _________ j ___ 6eaccnhme.SN=Z966.fN=O.flq=_61=100.SSID="ike 

::::~: rooe~ponse.SNa2967, FN=O. F1¥J$s--~llla100. S •• ~ _________ ;__________ ==::,~:::0.:~~:~::~~:•=•i 
0.136367 Authenliutior.SN=1798.FN=O.Flogs=,-

0.138331 

0.163541 

0.177520 

0.177978 

0.177990 

0.179295 

0.183007 

0.183962 

0.185016 

0.193412 

Assooat,on ~ SN - 1799,~N-O.flaq.s~ ssma•,unnr 

.n• I 2oU} 

- · I 3of4) 

I 

i ! 
'iliT/HE/EHT~NGNDl'Announcemeot.Sou..,.;= J 

i 
I 

Data.SN4071. FNOFtaos .p ... F. 

A<$ociatiooRequest,SN =1799,FN=O.Flags =._SSID="ike!i. 

A<$ociationR-,sponw.SN=20.FN=O.Flag<a_ 

VHT/HE/EHT/RANGJNG NOP Announcement Sounding Oi,lo 

AruonNoAck.SN =2.fN=0,flags=-

Key(Meswge1of4) 

Key(Message2of4) 

Key(Me<.<age4d4) 

ActOC111.SN =1801. fN=O.flags=.p-

0..lit.SN=4071.FNaO,Flogsa.p....F. 

Sharkliest'25 c~ 
EU~PE ~ 
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Beacon frame

• Choose Display Filter button, Management 
-> Beacon and click one of Beacon frames.

• Beacon frame is broadcast by AP 
periodically, including Wireless specs.

• Open IEEE802.11 Wireless Management -> 
Tagged parameters.

• You can find SSID in Tag: SSID parameter 
set if AP is not set in stealth mode.

• There are many Tags, including AP’s specs, 
such as HT(.11n WiFi4), VHT(.11ac WiFi5), 
HE(.11ax WiFi6) and EHT(.11be WiFi7)

p pg 

File Edit View Go Capture Analyze Statistics Telephony Wireless Tools He lp 

No. Time PHY type CH Freq. Sig nal MCS Rate Retry Type/ Subtype 

1 0. 000000 802.lla (OFDH) 53 6215MHz -62 dBm 

v I EEE 802 . 11 Wi r e l ess Ma nagement 

v Fi xed pa r amete r s ( 12 by tes ) 

Timestamp : 16339353683 

Beaco n Interval : 0 . 10 2400 [Second s ] 

> Ca pabilit i es I nformat i on : 0x1131 

v Tagged pa r amet e r s (441 byt es ) 

v Tag: SS I D pa rame t er s e t: "' i ke ri ri7"' 

!Tag Numbe r : SSI D pa ramet er s e t ( 0 ) 

Tag l ength : 8 
SSI D: " ike r i ri 7" 

> Tag: Supported Ra t e s 6 ( 6 ) , 9 , 12( 8 ) , 18 , 24 (6), 36 , 48 , 54 , [ l•lbit / s ec ] 

> Tag: Tr af fi c I ndi catio n Ma p (TI M): DTIM 0 of 1 bitmap 

> Tag: Co unt r y I nfo r mat i on : Coun t r y Code JP, Enviro nment Gl oba l o pe r a t ing 

> Tag : Powe r Const r a i nt : 0 

> Tag: TPC Repo r t Tr a nsmit Powe r : 22 d Bm 

> Tag: Tx Pm•e r Enve l ope 

> Tag: Tx Pm•e r Enve l ope 

> Tag : RM Enab l ed Capabilit i es ( 5 oct ets ) 

> Tag : AP Channe l Repo r t : Ope r at ing Cl ass 131 , Chan nel Li st 1 , S, 9 , 13 , 

> Ta g: RSI! I nfo rmat i o n 

) Tag : QBSS Load El ement 80 2 . l l e CCA Ve r s i o n 

> Tag: I nte r1•o r king 

> Tag: Adve rt i s ement Protoco l 

> Tag: Extended Ca pa bilit i es ( 11 oct et s ) 

> Tag: Vendo r Specifi c : Micro soft Co r p . : vJMM/l,J11E: Pa r amet e r El ement 

> Ext Tag: HE Cap ab i lities 

> Ext Tag : HE Op er ation 

> Ext Tag : Spa t ia l Re us e Paramete r Set 

> Ext Tag: MU EDCA Paramet er Set 

) Ext Tag : HE 6 GHz Band Capabi l it i es 

> Tag: Ve ndo r Spec i f i c : MediaTe k I nc 

> Tag : Vendo r Spec i f i c : Med i aTe k I nc 

> Tag : Ve ndo r Specif i c : i.i -Fi Alli ance : Mu l t i Band Ope r a t i o n - Opt i mized C 

> Tag : Ve ndo r Spec i fi c : Med i aTe k Inc 

) Tag : FI LS I nd i catio n 

> Tag: RSN ext ens ion ( 1 octet ) 

> Tag : Vendo r Spec i f i c : Med i aTe k I nc 

) Ext Tag : Mul t i - link ( 802. llbe D3. 0 ) 

> Ext Tag: EHT Ca pab i lit i es (80 2 . llbe D3 . 0 ) 

) Ext Tag: EHT Oper at i o n (802 . l l be D3 .0) 

> Ta g: Ve ndo r Spec i fi c : Buff a l o . I nc 

: Beacon frame 

Source 

BuffaloAP 

Destinat io n SSID BSSID 

Br oadcast "' i keriri7" Buffa] 

All 

Beaco n 

Sharkliest'25 c~ 
EU~PE ~ 
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WiFi generation

16

Generation Name band Wireless LAN Management fields

4 (IEEE802.11n) HT 2.4/5GHz HT Capabilities, HT Operations

5 (IEEE802.11ac) VHT 5GHz VHT Capabilities, VHT Operations

6/6E (IEEE802.11ax) HE 2.4/5GHz HE Capabilities, HE Operations

7 (IEEE802.11be) EHT 2.4/5/6GHz HT Capabilities, HT Operations

• We can find supported generations by Wireless LAN Management fields.
v Tagged pa r amet e r s ( 441 bytes ) 

v Tag : SS I D parame·te r s ,et: " i be r i 1r i7" 

!Tag Number : SSID para me t e r s et ( 0 ) 

) 

) 

) 

) 

) 

) 

) 

) 

) 

) 

) 

) 

) 

Tag l e ngt h : 8 

SSI D: " i ke iri ri7" 

Tag : 

Tag : 

Tag : 

Tag : 

Tag : 

Tag : 

Tag : 

Tag : 

Tag : 

Tag : 

Tag : 

Tag : 

Tag : 

Supp or t ed Rat es 6 ( B) , 9 , 12( B) ~ 18, 24 ( B) , 36., 48 , 54, [Mbit/ sec ] 

Traf ·fic I ndi cat i o n Ma p (TI M) : DTI,M 0 of 1 b i t map 

Co un t r y I nfo1r ma t i o n : Co unt 1r y Code JP,, Envi r o nme nt Glo ba l o pe r ating c l ass,es 

Powe r Co nst r a i 1fl t : 10 

TPC Report Tran smi t Poire r : 22 d Bm 

Tx Powe r Enve lop e 

Tx PoL11e r Enve lop e 

IRM Enab l e d Capalbilities ( 5 oc t et s ) 

AP Cha nn e l Report Operat i ng Class 1 31., Cha n ne l List 

RS N I nf ormati o l'I 

QBSS Load Element 802 .lle CCA. Ve r sion 

[ nt e r L11o r king 

Adve·r ti s,emen t Protoco l 

1 , s .. 9 , 13., 17 , 21., 

Sharkliest'25 c~ 
EU~PE ~ 
~ M1 ~ ~ 

,U~ 

) Tag : Ext e nded Ca pab i lities ( 11 odets ) 

.,... ..... 1.a1....,..M..1,1,1,i,1,1i1,.....;1,1,1,1..1.,,1.i..i......,..1o1.w...,o soft Co r p . : WMM/ l-JM'E: Pa r ame t e r Eleme nt 
) Ext Tag ::: HE Ca pa bilit ies 

) Ext • a t i ol'I 

) Ext Re us,e Pa r a m:et e1r Set 

) Ext Tag ::: ML.I EDCA Pa ramete r Set 

) Ext T,ag ::: HIE 6 G'Hz B.a11'1 1d Capa b i lit ies 

) Tag : 

) Tag : 

) Tag : 

) Tag : 

) Tag : 

) Ta g : 

V,e ndor Specific : 
V,e nd or Spec i f ic : 
V,e nd or Spec i f i ,c : 

V,e nd or Specific : 

FI LS I ndication 

IRSN exte ns ion ( 1 

MediaTe k I nc 

Med iaT,e k I nc 

!~i -F i Allia n ce 

Med iaT,e k I nc 

o c t e t ) 

) Tag : Vend or Spec i f i ,c: MediaTe k I nc 

) Ext Tag ::: Multi-Li nk ( 80 2. U b e D3. 0 ) 

) Tag : Vendor Spec i f i,c: Bu ffa l o .. I nc 

Mul t i Ba nd Oper at i o n - Opt imized Connectiv 
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Finding WiFi generations from Beacon

17

• Andy-san (Andrew Walding, famous for Wireshark Profiles 
Repository, founder of CELLSTREAM) submits Wireshark Discord

We can find WiFi generations from tags on Beacon from AP

Standards Display Filter

Pre-WiFi 4
Legacy

wlan.fc.type_subtype == 0x0008 and wlan.tag.number == 1 and not ((wlan.tag.number == 61) or 
(wlan.tag.number == 45) or (wlan.tag.number == 191) or (wlan.ext_tag.number == 192) or  
(wlan.ext_tag.number == 255) or (wlan.ext_tag.number == 108)) 

WiFi4
11n

wlan.fc.type_subtype == 0x0008 and ((wlan.tag.number == 61) or (wlan.tag.number == 45)) and not 
((wlan.tag.number == 191) or (wlan.tag.number == 192) or  (wlan.ext_tag.number == 255) or  
(wlan.ext_tag.number == 108))

WiFi5
11ac

wlan.fc.type_subtype == 0x0008 and ((wlan.tag.number == 191 or (wlan.tag.number == 192)) and 
not ((wlan.ext_tag.number == 255 or wlan.ext_tag.number == 108)))

WiFi6
11ax

wlan.fc.type_subtype == 0x0008 and wlan.tag.number == 255 and not wlan.ext_tag.number == 108 

WiFi7
11be

wlan.fc.type_subtype == 0x0008 and wlan.ext_tag.number == 108
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Probe Request and Probe Response

• Choose the Display Filter button, 
Management -> Probe Req and Res

• Ctrl + [Up], Ctrl + [Down] to compare 
IEEE802.11 Wireless Management Header

• STA sends SSID, HE, EHT and Vendor
information by Probe Request, and AP 
sends back Probe Response with SSID, 
QBSS, HE, Multi-Link (Aggregating 2.4/5/6 
GHz connections) and Vendor information

typ - typ {. } 

IE EE 802.11 Wi r eless Management 

) Fi x e d pa r a.met e r s ( 12 by tes ) 

v Tagged par amete r s ( 419 bytes ) 

> Tag : SSI D pa rameter set : " i ke r i r i7 " 

> Tag : Suppo r ted Rat e s 6 ( 8 ) , 9, 12 ( 8 ) , 18, 24 ( 8 ) , 36, 48, 54 , [r-tbi t 1 

) Tag : RS I~ I nf o rmatio n 

> Tag : Exte nded Capabil i ties (11 oct ets ) 

> Tag : QBSS Load Eleme nt 802. lle CCA Version 

> Tag : I nt e r1~o rki ng 

) Tag : Ad ve r t isement Protocol 

) Tag : Vend o r Speci fie : Microsoft Corp . : ~JMM/\JM E: Pa r amete r Element 

> Tag : RM Enab l ed Capa bi lit ies ( 5 octets ) 

> Tag : AP Cha nnel Repo rt: Operating Class 1 31 , Cha nne l List : 1 , 5 , 

> Tag : Po1, e r Cons t r ai nt: 0 

) Tag: TPC Report Tr a nsmi t Pov,e r : 22 dBm 

> Tag : Tx Power En ve l ope 

> Tag : Coun t r y I nf o r mat i on : Cou nt r y Cod e JP, Environme nt Gl oba l oper 

> Ext Tag: HE Capabilit ies 

) Ext Tag : HE Ope r ation 

) Ext Tag : Spat ia l Re use Pa ramete r Set 

> Ext Tag : MU EDCA Pa rameter Set 

) Ext Tag : HE 6 GHz Band Capa bi liti es 

) Tag : 

) Tag : 

> Tag : 
) Tag : 

) Tag : 

) Tag : 

Vend o r Specific : 

Vend o r Specif ic : 

Vend or Specific : 

Vend o r Specif ic : 

FI LS I nd icatio n 

RS I~ extension (1 

Med iaTe k I nc 

Med iaTe k I nc 

Med iaTe k I nc 
\,J i - Fi All i ance : 

octet ) 

> Ta g: Vend o r Specific : Med iaTe k I nc 

> Ext Tag: Mu l ti - Link ( 80 2 . ll be D3 . 0 ) 

Mu l ti Ba nd Oper at i on - Opt iJJ 

) Ext Tag : EHT Capabil i ties ( 80 2 . llbe D3. 0) 

) Ext Tag : EHT Oper at i on ( 802. l l be D3 .0 ) 

> Tag : Vend o r Specif ic: Buffa l o . I nc 

g 

All 

Beaco n 

Pro be Request 

Probe Responses 

Probe Req and Res 

Sharkliest'25 c~ 
EU~PE ~ 

r.::,,'=1 ~ ~ 
. ~ ~ 



#sf25eu

QBSS Load Element 802.11e CCA

• QBSS(QoS Basic Service Set) Load 
Element is defined by IEEE802.11e

• CCA (Clear Channel Assessment) is 
the PHY-layer mechanism used to 
determine whether WiFi is busy.

• QBSS Load Element 802.11 CCA 
Version contains network load 
information: Station Count, 
Channel Utilization and Available 
Admission Capacity in Probe 
Response by AP

• STA determine which AP is the best 
from the QBSS Load Element 

Field name Contents

Station Count
Number of Stations 
associated with the 
BSS

Channel Utilization
Percentage of the 
channel was sensed 
as busy 

Available Admission 
Capacity

Remaining capacity 
available for new 
QoS

• Some Beacons may contain QBSS Load Element 802.11e CCA

v Tag : QBSS Load El eme1nt 80:2 . 1 11. e (CA Ver s.io:n 

!Tag Number : QBSS Load Element (11) 
Tag l 1engt h : 5 

QB,SS Vier s ion : 2 

St art .io rn Count • 10 

Channe l Utilization : 6 ( 2%) 
Avai lab l e Ad i ssion Capacity: 31:250 {1000000 us / s ) 

Sharkliest'25 c~ 
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Authentication (Open Systems/SAE)

• Choose the Display Filter button, 
Management -> Authentication

• Ctrl + [Up], Ctrl + [Down] to compare 
IEEE802.11 Wireless Management Header

• This datalink uses Open System, STA and 
AP exchange Authentication frame, 
confirms SSID name for authentication.

• If you find Open System, this connection 
uses WEP/TKIP/WPA2, we may decrypt if 
you captured the complete 4-way 
handshake and we knew PSK.

• If you find SAE, it uses WPA3

[I I typ - t}p 

No. T1ime PHY type CH Fireq. Sigin al MCS Rate Retry Type/Subtype Source 

Authe t ica tion 

) Frame 4 : Pac ket , 75 bytes 011 ,~ire ( 6100 b i ts ), 75 bytes captu r ed ( &00 bits ) 011 interf ace un lmm~11 

) Ra diotap Head e r v0 , Lengt h 32 
'\ RA? 1 1 r ;arH"' in'fn r-m;a+i ,nn 

I EEE 80 2 . 11 i r el ess Management 

v Fixed pa r amet,e r s ( 6 lbytes ) 

Al!J1the1rn t i catio rn Al go r ithm: Op en Sy st,em ( 0) 

Al!Jrthell'il t i c atio n SEQ : 0x0001 

Status code : Successf ul ( 0:x.0000 ) 

v Tagged pa ametie r :s ( 1.3 hy tes ) 

v Tag : V,e ndor Spec i f:i.,c : App jJ_e ,, I nc . (Data: 0 

Tag Numoer : Vie ndor S:p ec i f .k ( 2.21 ) 

BuffaloAP 

Tag Len,gth : H 

OUI : 00 : 17 : f 2 (Apple,, I nc . ) 

Vendor Specif ic O~I Ty pe: 10 

Type : ] 0 

Data: 000104000000001 

Broadcast 

1 Authent1cat1on SN=,9 FN=O Fla s= 

iPhoneSTA 

Destii nat ion SS ID BSSID 

0000 00 00 20 0 0 6f 00 04 00 
0010 00 0c 47 18 00 00 c S aa 
0020 h0 00 3c 0 0 84 e 8 d b 45 

Sharkliest'25 c~ 
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All 

Be.aco 11 

Pro be Request 

Pro be Respo rnses 

Pro be Req and Res 

Authenticat io n 

:llmi: 
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Asssociation Request and Association Response

• Choose the Display Filter button, 
Management -> Association Req and Res

• Ctrl + [Up], Ctrl + [Down] to compare 
IEEE802.11 Wireless Management Header

• WiFi datalink is created between STA and 
AP, exchanging actual connect specs.

• This connection uses WiFi7 and MLO (we 
can find EHT, IEEE1905 Multi-AP, Multi 
Band Operation tags.

[I I w lari.fc.type_subtype in {0, 1} 

No. Time PHY type CH fire-q. Siginal M CS Rate R.et:ry Type/Subtype 

8 0.138331 802.lla ( OFDM) 53 621511-!z -58 dBm 6 Association Request 

I 10 0 . 163541 802.lla {OFDM) 53 6215MHz -61 dBm 6 Association Respon se 

> Frame B· Packet , 247 bytes o n ,~i r e (1976 bi t s ) , 247 by tes capt ur ed ( 1976 bits) on 

> Radiotap Header v0 , Length 32 

> 802 . 11 r adio info r mation 

> I EE E 80 2.11 Associatiofi Reques t , 

V IEEE 802.11 i r el ess Management 

V Fixed par amet,er s ( 4 bytes ) 

• I EE E 802 . 11 i r eless Managemen t 

> Fixed par amet,er s ( 6 lby·tes ) 

v Tagged paramet e r s ( 258 bytes) 

Flags : .. , ... ... 

-

> Tag : Suppo1rted Rates 16(B) , 9_. 12( B), 18, 24 ( B) , 316., 48 , 54 

) Tag : Vendo1r Spec i f ie l.Ji -Fi All iance : I EEE1905 i"l ulti- AP 

> Tag : RM Enab l,ed Cap.abilities ( 5 oct ,et s ) 

> Tag : Ve ndo1r Speci f i,c: Micr osoft Corp .. : L,/Mf' /loJJ11E: !Pa r amet e r 

) Tag : IBSS Max I d l e Period 

) Ex:t Tag : HIE Ca pabilit ies 

) Ex:t Tag :: HIE Operatio ri 

> Ex:t T.ag :: Spat ia l Reuse Paramete1r Set 

> Ex:t Tag :: r1u EDCA Paramet er Set 

) Ex:t Tag : HIE 6 GHz B,a1r1d Capalb i lities 

> Tag: Extended Ca pabilit i es ( 11 oct ets ) 

) Tag: Vendo1r Speci f i,c: MediaTe k I nc 

> Tag : V,end o1r Spec i f k: MediaT,ek I nc 

> Tag : V,end o1r Specific l.Ji -Fi Allian ce : Multi Band Oper at i on 

) Tag : FI LS I nd i ca tio:ri 

) Tag : IRSN extension i(1 o c t et ) 

> Tag : V,endo1r Spec i fi,c : MediaT,ek I nc 

) Ex:t Tag : EHT Capabilities ( 802 . Hbe D3 . 0 ) 

) Ex:t Tag : EHT Oper at i o n ( 802 . :llbe D3. 0 ) 

> Tag : V,endo1r Spec i f ic Buffalo .. I nc 

Source DestJi nat ion SSID 

iPhoneSTA BuffaloAP "i keriri7'" 
BUJffaloAP i PhoneSTA 

i nte r f ace UI 0000 0 0 00 20 00 6f 00 
0010 100 0c 47 18 00 00 
0020 0 0 00 3c 00 84 e8 
0030 84 e8 cb 45 l d b8 
0040 65 72 ,6J9 72 69 37 
0050 21 02 f 2 13 24 0 2 
0060 01 00 00 ,0f ac 04 
,....,.,.--,r:i, "" .. - ,. _ _ .. ,. ., .... ..... 

- + 

BSSID 

Buffa~ 
Buffa ] 

04 00 
c6 aa 
db 45 
701 70 
01 08 
01 18 
01 00 
,, ,. - -
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Manage men 

All 

Control fram e: 

Pro be Request 

Pro be es,pomes 

Pro be Req and Res 

Authenticat io n 

Ass.o<:iation Req uest s 

Ass.o<:ia • on Responses 

Ass.o<:ia ·on Req and Res 
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EAPOL 4 way handshake

• Choose the Display Filter button, 
EAPOL, to filter 4-way handshake

• There are 4 packets between AP 
and STA to create a PTK (Pairwise 
Transient Key) keyring, including 
TK(Temporal Key) for the session, 
AP sends GTK (Group Temporal 
Key) for broadcast and multicast 
communication

• Message 1 from AP contains source MAC and AP’s Nonce

• Message 2 from STA contains source MAC and STA’s Nonce

• Message 3 and 4 are encrypted (Message3 contains GTK)

[ I eapol 

No. Time PHY type CH Freq. Signal 

14 0.177990 802.11a (OFDH) 53 621511-!z -60 dBm 

I 16 0.179295 802.lla (OFDM) 53 6215MHz 
18 0.183007 802.lla (OFDM) 53 6215MHz 
20 0.183962 802.lla (OFDM) 53 6215MHz 

) Ra diotap Header v0, l ength 32 

) 8102. 1 1 r adio info rmation 

-58 dBm 
-60 dBm 
-59 dBm 

) IEEE 802..11 QoS Dat a,, Flags : .. .... F. 

) l ogic.a l - Link Contro l 

v 802. l X A11Jthenrt::icait i on 

Vers ion : 802 . ]X - 2004 ( 2) 

Ty pe: Key ( 3 ) 

Lengtlh :: 117 

Key [) es c rip tor Type : EAPO L IRSN Key (2 ) 
[ Message number : 1 ] 

) Key I 1nformation :: 0x00188 

Key Le ngth : 16 

Replay Gounter: 1 

MCS Rate Retry Type/ Subtype Source 

6 QoS Data BuffaloAP 
6 QoS Data iPhoneSTA 
6 QoS Data BuffaloAP 
6 QoS Data iPhoneSTA 

l~PA Kiey Nonce : c b4b87d 98151b 1,e c aef9,cc ef89bf 1.1 f58oe af 6aia8 3 2a a.d66fef 997 4 f3 dlf 6f 6 1 c8 

Key IV:: 00000000000000000000000000000000 

l~PA Key RSC : 0000000000000000 

!~PA K,ey ID : 00000000000000001 

!~PA K,ey MIC : 00000000000000000000000000000000 

l~PA Kiey Data Le ngth : 22. 

) l~PA Key Data : dd14000rfac04801.e3ae1.385703ec57547f0:92.fec0 550 

Destination SS ID 

iPhoneSTA 
Buffal oAP 
iPhoneSTA 
Buffal oAP 

Sharkliest'25 ~ 
EU~PE ~ 

Im CJ • j + Management., Control Frame~ Dat~ Signal,. Rat~ Ret ry EAPOL 

BSSID STA Info 

BuffaloAP iPhoneSTA Key (Hessage 1 of 4) 
BuffaloAP iPhoneSTA Key (Message 2 of 4) 
BuffaloAP iPhoneSTA Key (Message 3 of 4) 
BuffaloAP iPhoneSTA Key (Message 4 of 4) 
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#14 #16 #18 #20 4 way handshake of EAPOL

23

AP
Authenticator

STA’s Nonce and STA’s MAC with MIC

AP’s Nonce and AP’s MAC address

STA creates PTK from PMK,
AP’s Nonce, AP’s MAC,

STA’s Nonce and STA’s MAC

STA
Supplicant

AP creates PTK from PMK,
AP’s Nonce, AP’s MAC,

STA’s Nonce and STA’s MAC

GTK and MAC address with MIC

ACK

802. l X Authenticat i on 

Ver s i on : 802.lX- 2001 (1 ) 

Type: Key ( 3 ) 

Length : 138 

Key Descript o r Ty pe : EAPOL :Rs r~ Key ( 2 ) 

[ Message number: 2 ] 

) Key I nfor mation : 0x0108 

Key Le ngth : 0 

Replay Counte r : 1 

lJPA Key r~once : 588a0a47e032159122d43a76d98593ab'S 

Key IV: 00000000000000000000000000000000 

lJPA Key RSC : 0000000000000000 

lJPA Key ID : 0000000000000000 

lJPA Key MI C: cdf56fl f2ed869fd cbb4ce91969ad699 

lJPA Key Data Lengt h : 43 

) lJPA Key Data : 30 260100000fac040100000fac04010000 

80 2.lX Authe rnticatio rn 

Ver sio n 802 . l X -2001 ( 1 ) 

Ty pe: Key ( 3 ) 

Lengtlti :: 95 

Key Des cripto r Ty pe : EAP,OL IRSH Key ( 2 ) 

[Message number : 4 ] 

) Key I 1rnforrnat ion :: 0x0,308 

Key Le ngth : 0, 

Replay Count ,e r : 2 

lllPA Key Honc e : 0000000000000000000000000000000 

Key IV: 00000000000000000000000000000000 

l-JPA Key RSC: 0000000000000000 

lllPA K,ey ID : 0000000000000000 

l-JPA Key MI C: 0fb4 5b c999e2c0e8ca4320,a6427c a9l a 

lllPA K,ey Data Length : 0 

802 .lX Aut henticat i on 

Version : 802 . l X-2004 ( 2 ) 

Type: Key ( 3) 

Length: 117 
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Key Descript or Type: EAPOL RS'N Key ( 2) 

[Message number : 1 ] 

) Key I nfor mation : 0x00,88 

Key Length : 16 

Replay Counter: 1 

lJPA Key Nonce: cb4b87d9815blecaef 9ccef 89bfll f 58cea f6aa8 32ac 

Key IV: 00000000000000000000000000000000 

lJPA Key RSC: 0000000000000000 

lJPA Key ID : 0000000000000000, 

lJPA Key MI C: 00000000000000000000000000000000 

lJPA Key Data Lengt h : 22 

) lJPA Key Data : dd14000fac0480,]e3ae1385703ec5754 7f 092fec0550 

8102 . l X Aut he nticat i o n 

Ver sion :: 802. l X-2004 (2 ) 

Type: Key ( 3 ) 

Lengtlti : 183 

Key Descriptor Ty pe: EAP.OL IRSH Key (2) 

[ Message numb er ::: 3 ] 

) Key I 1rnfonmat i o n ::: 0x13c8 

Key Length : 16 

Replay Count e r: 2 

l-JPA Key Honce : cb4b87d981'5b l ,ec aef 9,cce f89bfllf58< 

Key IV: 00000000000000000000000000000000 

l-JPA Key RSC : 0000000000000000 

l-JPA K,ey IO : 0000000000000000• 

l-JPA Key MI C: b3483369e6d8'59a57cacac3337e37636 

l-JPA K,ey Dat a L,engt h : ,88 

ll-JPA Key Dat a: aaa9777ad55f4f133366827adc01a2e0f : 
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Decrypting WPA2 PSK
Use Pre Shared Key : SSID to decrypt WPA2-PSK
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Wireless with Wireshark

• Open the trace wpa2wpa3.pcapng

• There are two WiFi connections by same STA (e2:da:1e:a8:92:8f) as 
iPadSTA and same AP (f0:2f:74:c4:f5:c4) as ASUS_AP

• Both connection use same SSID: ikeriri6 and pass phrase: wireshark

• The first connection from #1 to #13 is WPA2 PSK

• The next connection from #14 to #27 is WPA3 PSK

File Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help 

~ ■ L~ ® ~ Ill':! ~ ~ <SaeS> ~Hf!\. ;; - ~ ~ €l. !H tl 
I I Apply a display fi lter ... <Ctrl-/> c ·I + Management Control Frame~ Dato. SignaL Rate.. Retry EAPOL 

No. Time CH Freq. Signal M CS Ra te Ret ry Type/ Subtype Source Destination SSID BSSID STA Info 

6 Auttient ication Authenticat ion, 

3 0. 002746 802 . lla { OFDH) 56 5280MHz -41 dBm 6 Associat ion Request iPadSTA ASUS_AP "ikerir i 6" ASUS_AP Association Request, SN=834, FN=0, Flags• . .. . . .. 

4 0 . 005013 802 . lla (OFDH) 56 5280MHz - 33 dBm 6 Assoc iation Response ASUS_AP i PadSTA ASUS_AP Assoc iation Res ponse , SN•l , FN• 0, Flags• . . . . . ... 

5 0 . 008401 802 . lla { OFDH) 56 5280MHz -33 dBm 6 QoS Data ASUS_AP i PadSTA ASUS_AP iPad5TA Key {Message 1 of 4) 

6 0 . 010452 802 . lla ( OFDH) 56 5280MHz -41 dBm 6 QoS Data iPadSTA ASU5_AP ASUS_AP i Pad5TA Key (Message 2 of 4) 

7 0 .011950 802 .lla { OFDH) 56 5280MHz - 33 dBm 6 QoS Data ASUS_AP iPadSTA ASUS_AP iPadSTA Key {Message 3 of 4) 

8 0. 013064 802 . lla { OFDH) 56 5280MHz -41 dBm 6 QoS Data iPadSTA ASUS_AP ASUS_AP iPadSTA Key {Message 4 of 4) 

9 0 .072760 802.llax { HE ) 56 5280MHz -41 dBm QoS Data i Pad5TA I Pv611cas_ ASUS_AP i Pad5TA QoS Data, SN•0, FN• 0 , Flags•op . . . . . T 

10 0 . 072892 802 . llax { HE ) 56 5280MHz -41 dBm QoS Data iPadSTA ASU5TekC- ASUS_AP iPadSTA QoS Data, SN•l, FN• 0, Flags•op . . . . . T 

11 0.073031 802.llax { HE ) 56 5280MHz -41 dBm QoS Data i PadSTA Broadcast ASUS_AP iPadSTA QoS Data, SN•2, FN=0, Flags•op . .... T 

12 0 .073376 802.llax { HE) 56 5280MHz -41 dBm QoS Data i PadSTA IPv611cas- ASUS_AP iPadSTA QoS Data, SN=3 , f N: 0, Flags•op . ... . T 

17 621.043_ 802 .lla ( OFDH) 56 5280MHz -38 dBm 6 Assoc iation Request iPadSTA ASU5_AP " i kerir i6" ASUS_AP As sociation Request, SN•3843, FN• 0, Flags• ... . . . 

18 621 . 045_ 802. lla (OFDH) 56 5280MHz - 31 dBm 6 Assoc iat i on Response ASUS_AP i PadSTA ASUS_AP As soc iat i on Re sponse , SN: 2, f N: 0, Fl ags: . . . ... . . 

19 621.049- 802. lla { OFDH) 56 5280MHz -31 dBm 6 QoS Data ASUS_AP iPadSTA ASUS_AP iPadSTA Key {Message 1 of 4) 

20 621. 0 51- 802. lla { OFDH) 56 5280MHz -38 dBm 6 QoS Data i Pad5TA ASUS_AP ASUS_AP i Pad5TA Key {Message 2 of 4) 

21 621.053_ 802 .lla ( OFDH) 56 5280MHz -31 dBm 6 QoS Data ASUS_AP iPadSTA ASUS_AP iPadSTA Key (Message 3 of 4) 

22 621. 0 54- 802. lla { OFDH) 56 5280MHz - 38 dBm 6 QoS Data i PadSTA ASUS_AP ASUS_AP iPadSTA Key {Message 4 of 4) 

23 621.402.. 802.llax { HE ) 56 5280MHz -40 dBm QoS Data i PadSTA IPv611cas- ASUS_AP iPadSTA QoS Data, SN: 0, f N: 0, Flags•op . .... T 

24 621. 402.. 802. llax { HE ) 56 5280MHz -40 dBm QoS Data i Pad5TA Broadcast ASUS_AP iPad5TA QoS Dat a , SN•l, FN•0, Flags•op . . . . . T 

25 621. 402.. 802 . llax HE 56 5280MHz -40 dBm QoS Data i PadSTA I Pv611cas_ ASUS_AP iPadSTA QoS Data, SN:2, FN: 0, Flags• op . . . . . T 
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Compare Authentication 

• Compare Open System of WPA2 
and SAE (Simultaneous 
Authentication of Equals)

• Use Display Filter buttons to select 
Management –> Authentication, 
Ctrl + [Up], Ctrl + [Down] to 
compare 802.11 Wireless 
Management Header

• Open System confirms SSID, 
exchange Status Code: Successful

• Each AP and STA sends Scalar and 
Finite Field Element value, SAE 
Message Type: Commit

• Then AP and STA exchange 
Confirm Value, SAE Message Type:
Confirm

• I EEE 802 11 i el ess a agernent 

v F • e . par-amete s 6 bytes) 
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hell'Tl t · ca i n l gor i thm: ~pe rn Sys te 0) 
llfthell'Tl t • c ati o rn SIE Q: 0~001 

Sa s co . e: Success u ( 0x0 00 ) 
) Ta gged pa ·amet er-s ·35 by tes ) 

I EEE 80 2 . 11 Wi r el ess Management 

v Fixed par amet ,er s ( 104 bytes ) 

A1J t he1r11t i cat ion Algorithm: Si m1Jltan eo11Js Aut hen tication of Equals ( SAIE) ( 3 ) 

A11J the1r11t i cation SEQ: 0<x0001 

Statu s code: Succe ssf ul ( 0x0000) 

SAE Mess age iype : Com:mi t ( 1) 

Group I ,d :: 2'56 - bit r ,andom ECIP gr oup (19 ) 

Scal ar: c67801ac5941dle0fad412b2'5'5567e53c885a0d1 2a22439a3e021c7d 633f 37,e7 

Finite Field Element : f4b7,c34e9f 0d5444381eld de353e54clcc838435b372a3933b7cc 

I EEE 802 . 11 i r el ess Management 

v Fixed par amet,er s ( 401 bytes ) 

A11J theint i catio rn Algo r i thm : Si m11Jltaneo 11J s Aut hentication of Equals ( SAE ) ( 3 ) 

A11Jtheint i cat i o n SEQ: 0rx0002 

Statu s code: Successf ul ( 0x0000) 

SAE rlessage lyp e: Confirm ( 2) 

Send - Co nfirm: 1 

Gonfi r m:: e0'5e00747ff.c,e2d04a55d7d7d32296c'51b8ffa07e5777d2df a3,f7a8 e74fce2343 
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SAE（Simultaneous Authentication of Equals) Handshake

• SAE（Simultaneous Authentication of Equals) is known for 
Dragonfly key exchange in RFC7664 https://www.rfc-
editor.org/info/rfc7664

Auth-Commit                               Auth-Confirm

● AP and STA calculate their own and the 
other side Scalar and Finite field 
element to create and share 
PE(Password Equivalent) value using 
Elliptic Curve cryptography

● Each Alice(STA) and Bob(AP) can verify 
the packet’s Confirm value with the 
calculated Confirm value

● K=rB・(sA・P＋eA) tr=(sB,eB,sA,eA)
cB=HMAC(Hash(K),tr) 

● If the calculated Confirm value is the 
same as the packet, we can share 
PE(Password Equivalent) value

Random: a, A 
sA = (a+A), mod q 
ellemen A= PE-A 

SS = {PE 58 X IP F 8 t 
= (PEb+B-B ,a 
= PEab 

sB,PF8 

Random: b, B 
sB = {b+B) mod q 
e ementB = PE-8 

ss = (PE5A X PE-A )b 

= (PEa+A-A )b 
- PEa,b 

Confirm-A = H sh(KCK I sc larA I 
el,ementA I elementlB) 
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Confirm-B = Ha,sh{KCK I scalars I b, 
ele entB I ,elementA) 

https://www.rfc-editor.org/info/rfc7664
https://www.rfc-editor.org/info/rfc7664
https://www.rfc-editor.org/info/rfc7664
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Confirm Data frames are encrypted

• Check data frame #9, 
#10, #11, #12 
encrypted by WPA2 and
#23, #24, #25 by WPA3

• Open IEEE802.11 QoS 
Data -> CCMP 
parameters header,
these frames contain 
CCMP Ext. Initialization 
Vector as a packet 
counter to protect 
against Replay Attack, 
AP and STA drops 
frames with old IVs

v I EE E 802. . 11 oS Dat a .,1 Flags : op ... . ., T 

Type/ Sub~ype : QoS ~ata ( 0x0028 ) 

) Frame Contr ol • el d : 0x88c1 

000 0 . 00 0010 1100 = Duration: 44. m" c roseconds 
) Receiver ad ir ess : ASUS_AP ( f 0::2f :74 : c4: f.5 : c4l-) 

) Transmi tter add r ess : iPadSlA ( e2: da ·le : a8 : 92.: 8f ) 

) Desti rn a ion a dd r ess : IPv 6m cas _ff : 01. '" 27: fa (33: 3.3 : f if : 01 : 2.7 :fa) 

) Sourc e ad . r ess : iPadST • ( e2 : da:1e:a8 '" 92:8f ) 

) BSS d : ·Sll.!IS_AP {f 0 : 2f,:: 74: ,c4 : 5, : c4-) 

) STA address: :iPadSTA ( e2: da : 1.e: a8: 92. &f ) 

. . . . ., . . . . , 0000 = F agmen. number: 0 

0000 0 .·00 0000 .. .. =Seq e~ce number: 0 

[ ~l.AN a gs : op '" . . . . l ] 

) Qos Cont r,o : 0x3 016 

) Co:rnt rol ( C) : 0x. 000b20f 

v CCMP par ameit: er-s 

lccMP Ext'" I itialization Ve ctor : 0x000000000002 

Key I mid ex : 0 

v Data ( 88 byte s) 

Oiirta : d ' 2. • 23703 25167.3 3724 8 6184cflb9 5 31849 ca 08f1 bf ' 3if180rf,d b96 . 

[ Length : 88] 
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IEEE802.11 decryption

• Wireshark supports WEP, WPA1/2 
decryption and doesn't support WPA3

• Wireshark also supports TK(Temporal Key) 
as a session key and MSK(Master Session 
Key) style decryption too.

• Right-click the IEEE 802.11 header, select 
Protocol Preferences -> Open IEEE 802.11 
wireless LAN preferences.

• Confirm “Enable decryption” is checked,
Open the “Edit…” button of Decryption keys.

• Note: you need to capture complete 4 
packets of EAPOL 4-way handshake and you 
need to know SSID and pre shared key.

v ~ EE E 802 . 11 QoS Data , 

Expand Subtrees 

Collapse Subtrees 

Expand AJI 

V [ 

Collapse All 

Apply as Column 

Apply as Filt er 

Prepare as Filter 

Conversation Filter 

Colorize with Filter 

Follow 

VO Graph 

Plot 

Copy 

Show Packet Bytes .. . 

Export Packet Bytes .. . 

Wiki Protocol Page 

Filter Field Reference 

Protocol Preferences 

Wireshark • Preferences 

IEC 60870-5- 103 

IEC 60870-5- 104 

I IEEE 802.11 

IEEE 802.15.4 

IEEE 802.l A I-I 

IEEE1609dot2 

IEEE1722 

iFCP 

ILP 

IMAP 

IM F 

INAP 

lnfiniband SDP 

Int erlink 

IPDC 

IPDR/SP 

iPerf2 

iPerf3 

IPMI 
IPPUSB 

IPSICTL 

1Pv4 

1Pv6 

Ctrl+Shift+I 

onds 

4 ) 
2 : 8f ) 

( 33: 33: ff :01 : 27: fa ) 

000002 

Ctrl+Shift+O a08flbf f 3f180fdb96deddd9cd807872fa65a2d0f 9af 6 

Ctrl+Shift+X 

Open IEEE 802.11 wireless LAN preferences ... 

IEEE 802.11 wireless LAN 

r.l Reassemble fragm ented 802.11 datagrams 

0 Ignore vendor-specific HT elements 

r.l Call subdissector fo r ret ransmitted 802.11 frames 

r.l Assume packet s have FCS 

0 Va lidate t he FCS checksum if possible 

Ignore t he Protect ion bit 

0 No 

0 Yes - wit hout IV 

Q Yes - with IV 

0 Enable WPA Key MIC l ength override 

WPA Key MIC Length override _0 ______ _ 

0 Treat as Sl G 

r.l Enable decryption 

Decryption keys Ed it .. , 

IEEE 802.11 UDP port(s) 
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WEP and WPA Decryption Keys

• You can set multiple WEP and WPA
decryption Keys in preference.

• Select Key type as wpa-pwd and set 
Key as [Pre shared key:SSID] style

• Select “wpa-pwd” from the list box 
and set “wireshark:ikeriri6”

W a d \NPA Decrypti n Keys 

Key 

v 11Viresharkikeriri6 

v IEEE 802.11 QoS Data, Fl ags : op ... . . T 

Ty pe / Subty pe: QoS [lata {0x0028 ) 

> Fr a me Cont r o l Fi e ld : 0 x88c l 

riri7 
ri ri,-5 g 

ri'r'i'-:J4g2 
c78g;9e1 147 

.0 00 00 00 0010 1100 ; Dur ation: 44 mic r o seconds 

> Receiv e r add re s s : ASUS_AP (f0 : 2f : 74 : c4 : f5 : c4 } 

> Tr a nsmi tt e r add r ess : iPad5TA ( e 2: da : l e : a 8 : 92 : 8f ) 

> Des t i na tion add r e s s : IPv6mcast_ff :01 :27: fa {33:33 : f f : 01 :27: f a ) 

> Sour ce ad d r ess : i Pad5TA ( e 2: da : l e : a 8 : 92: Sf ) 

) BS5 I d : A5U5_AP ( f 0:2f : 74 : c4 : f 5 : c4 ) 

) STA add r e s s : iPa d5TA ( e2: da : 1e : a8:92 : 8f ) 

.. .. . . .. .. . . 0000 ; Fr agment numbe r : 0 

0000 00 00 0000 . . . . ; Seque nce numbe r : 0 

[ III LAN n ags : o p . . .. . Tl 

> Qos Co nt r o l : 0x3016 

> HT Co nt r ol ( +HTC) : 0x0000b 20f 

v C0 1P pa r a mete r s 

lca 1P Ext . I nitialization Vector : 0x000000000002 

Key I ndex: 0 

v Data (88 byte s ) 

Data: df24 237032516733724bf86184cf b9 531849ca08f1bf f3f180fdb96d 

[ Le ngth : 88 ] 

dd8 

v IEEE 802 .11 QoS Dat a, Flags: op .. ... T 
Type / Subt ype : QoS Data (0x0028 ) 

v Fr ame Cont ro l Fie ld : 0x88c l 
. . 00 = Ve rsion : 0 

. .. . 10 . . ; Type : Data f r ame (2) 
1000 . . . . = Sub t ype : 8 

> Flags: 0xcl 
.000 0000 0010 1 100 = Duration: 44 mic r oseconds 

> Rece i ver address: ASUS_AP (f 0 :2f :74: c4 : f5 :c4) 
> Tr ansmi t t e r add r ess : iPadSTA (e2: da : l e: a8:92:8f ) 
> Destinat i on add r ess : IPv6mcas t _ff :01 :27: fa (33:33 : f f :01: 27 : f a ) 
> Sour ce add ress : iPadSTA (e 2:da :le : a8 :92 :8f ) 
) 855 Id : ASUS_AP ( f 0 : 2f:74 : c4: f 5 :c4) 
> STA addr ess: iPadSTA (e2 :da : le :a8:92 :8f ) 

. . . . . . ..... . 0000 = Fr agmen t number: 0 
0000 0000 0000 . ... = Sequence number : 0 
[ \, LAN Flags : op .... . T] 

> Qos Cont r ol : 0x3016 
> HT Co nt r ol (+HTC) : 0x0000bWf 
v C0 1P par ameters 

C0 1P Ext . I nitia l i zation Vector : 0x000000000002 
Key Inde x: 0 
[ TK: 4c102f d43613c 535404d0777088a6503 ] 
[ PMK: 31bb75a609a4 24aac01e9929b39458e87ea45 b0f30204f f5642bf 3067a6fd31f ] 

> Logical- Link Cont r ol 
> In t e r net Pr ot ocol Vers i on 6, Src: : : , Dst : f f 02: : 1 :ff01 :27fa 
> In t e r net Cont rol Message Prot ocol v6 
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WEP and WPA Decryption Keys

• We can find plaintext data frames
such as Neighbour Solicitation of 
IPv6(#9), ARP Requests(#10), DHCP 
Request(#11) and Router 
Solicitation of IPv6(#12) as the 
result of decryption of WPA2-PSK

• But We still can not decrypt WPA3 if 
we use the same SSID and Pass 
phrase, and if we have the complete 
set of SAE Authentications and 4-
way handshake.

Info 

Association Req uest , 5N=834, FN=0, Fl ags= . ..... . , 
Assoc i ation Res ponse , SN=l , FN=0, Flags= .. 
Key (Message 1 of 4 ) 
Key (Message 2 of 4 ) 

Key (Message 3 of 4 ) 
Key (Message 4 of 4 ) 
Neighbor Solicitation for fe80::lc42 c607:6801:27f 
Who has 192.168.50.1 ? Tel l 192. 168.50.236 
DHCP Request - Transaction ID 0xac9e7500 
Router Sol icitation 

Association Req uest , 5N=3843 , FN=0, Fl ags= 
Assoc i ation Res ponse , SN=2, FN=0, Flags= .. 
Key (Message 1 of 4 ) 

Key (Message 2 of 4 ) 
Key (Message 3 of 4 ) 

Key (Message 4 of 4 ) 
QoS Data, SN=0, FN=0, Flags=op ..... T 
QoS Data, SN=l, FN=0, Flags=op . ... . T 
QoS Data, SN=2, FN=0, Flags=op ..... T 
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) Frame 9 : Pac ket _. 1701 bytes o n wi re (1360 bits ) , 170 bytes capt ur ed 

) Ra di otap Head e r v 0, 11.. e ngt h 44 

) 802 .11 r adio info r mati on 
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Wireless in Live Action
Actual use case of Wireless packet capturing
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WiFi capturing in Live Actions

• We can capture the complete set of 4-way
handshake and connection sequence 
between AP and STA, if we test in the 
Anechoic Chamber or in the shield box.

• But wireless packet analysis in live actions 
is far different, we merely capture the 
complete sets of 4-way handshakes, nor 
connection sequences.

• WPA3 and PMF(Protected Management Frame) is common now.

• But we still get the various information about the Wireless 
environment from the trace file. 

• WiFi SIGINT is WiFi Signal Intelligence, get Important Information 
like finding the needle in a haystack of the WiFi trace file
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WiFi SIGINT (WiFi Signal Intelligence)

• It is inevitable to drop many wireless packets, 
and we need a huge amount of time and money 
to get all frames, and it may be impossible. We 
do not have to pursue full capturing.

• We do not have to lock in fixed WiFi channel, 
but switching channel in short interval, 
scanning wireless environment.

• 200ms/CH is good parameter of WiFi scanning, 
because 100ms is usual time of Beacon interval 
of the AP

• For example, set your WiFi capture equipment 
to scanner mode, set all 2.4/5/6GHz channels,
capture WiFi packets at 200ms/CH
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WiFi SIGINT (WiFi Signal Intelligence)

• We have smart devices everywhere and every time, and all 
devices have WiFi and their MAC address.

• When you visit your favorite cafe, you bring your MAC address 
and your information.

• We can map the network, identify devices and access points, 
detect unknown STAs, rogue APs, attackers and so on

'li;::_--~--~~~~imff 1fui~~~~~-~ 
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WiFi SIGINT (WiFi Signal Intelligence)

• CEATEC 2025 is one of the biggest 
IT conference events in Japan.

• Ikeriri booth is located at Hall 6 in 
the 75,000㎡ square feet of 
Makuhari Messe, Chiba prefecture.

• Open wifisigint.pcapng, 11MB trace 
file at  15:25:21 to 15:25:41 (79 
seconds) in 14th, October, the first 
day of the conference 

• Choose Statistics -> Capture File 
Properties to confirm the number 
of packets (53809), size of the 
trace file
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Wireless LAN Statistics

• Choose Wireless -> WLAN Traffic 
to display Wireless LAN Statistics

• We can sort, extract and right-click to filter BSSID, Channel, SSID, 
Percent Packets, Percent Retry, Retry, Beacons, Data Pkts, Probe 
Reqs, Probe Resps, Auths, Deauths, Other and Protection Columns 

wifis1g1 ntpcap11g 

File Edit Viiew Go Capture Analyze Statist ics le!ephony Wireless Tools Help 

-4, ■ 

[ 11 Apply a display fi lter ... <Ctrl-/> 

No. T1ime PHY type CH Freq. Signal MCS I 

\ ;\fj reshark , Wireless LAN Stati sties , wifisigin . pcapng 

sssm Channel SS ID 

> <Broadcast > 

> 00:00:00:00:.00:00 <Broadcast > 

> 00:09:b4:71::01:18 132 0000.s.oftlba nlk 

> 00:09: b4: 71 ::07:8c 112 0002.softiba nlk 

> 00:09: b4: 71 ::0a:cO 124 0O0Osoftiba rnlk 

> 00:09:64:71::13:48 116 ABGeatec_EXT 

> 00:09:b4:71::15:2f 11 0000.s.oftiba nlk 

> 00:09:b4:71::15:30 140 0O00s,oftiba rn lk 

> 00:25:00:ff::94: 7 3 <Broadcas "> 

> 0OQb:fS:5 be85:2e 1 <Broadcas > 

> 0OQb:fS:S bi85:30 128 Buffalo-5G-8520 

Display fi lter: Enter a display filter ... 

Bluetooth ATT Server A ributes 

Bluetooth Deviaes 

Bluetooth HCI Summary 

WLAN Traffic 

Percent Packets Percent Retry 

,0,,0 ,0,,0 
,o,,o ,o,,o 
,0.1 38.5 
,0,,0 33.3 
ia.,o 75.0 
,0,1 I 6.3 
,o,,o ,o,,o 
,0,1 25.0 
,0,5 ■ 14.9 
,0,,0 ,o,,o 
,0.1 10.10 
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□ X 

Retry Beacons Data Pkts l obe IRe,qs l obe IResp Auths Deauths Other Protection 

0 0 2 0 0 0 0 0 

0 0 0 0 0 0 0 2 

5 4 3 0 6 0 0 0 Un lmown 

0 0 1 2 0 0 0 

3 0 0 0 4 0 0 0 

1 1 0 11 4 0 0 0 

0 2 0 0 0 0 0 0 

3 3 0 0 9 0 0 0 

10 0 4 0 0 0 0 63 

0 1 0 0 0 0 0 0 

0 2 0 0 11 0 0 0 

Apply 

Copy Save as ... Close HeJp 
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Counting the transmitter of wireless traffic

• tshark is a good tool for counting APs and STAs

• Let’s list Transmitter address (wlan.ta) of the wifisigint.pcapng

• Use –T fields –e wlan.ta options to pick up Transmitter Address

• Redirect the result as TA.txt and cat TA.txt | sort | uniq | wc –l
to count up the unique MAC address of the transmitter.

C:\Users\megumi\Desktop>tshark -T fields - e wlan.ta -r wifisigint.pcapng 
d0:65:78:17:f8:22 
f5:d5:80:ld:01:e0 

C:\Users\megumi\Desktop>tshark - T fields - e wlan.ta - r wifisigint.pcapng >>TA.txt 

C:\Users\megumi\Desktop>bash 
/mnt/c/Users/megumi/Desktop 

cat TA.txt I sort I uniq I we -l 
13UU 
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Counting the number of AP and STA

• AP sends Beacons, so counting unique AP  by using
–Y wlan.fc.type_subtype==8 and redirect as AP.txt

• Counting AP using sort, uniq and wc –l 
There are 215 Aps in this trace file

• All MAC addresses 1344 - AP’s MAC address 215 = 1129 STAs

C:\Users\megumi\Desktop>tshark -T fields -e wlan.ta -r wifisigint.pcapng -Y wlan.fc.type_subtype==B >>AP.txt 

C:\Users\megumi\Desktop>bash 
/mnt / c/Users/megumi/Desktop 

cat AP.txt I sort I uniq I we -l 
215 
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Privete MAC Address

• A private MAC Address is a locally administered MAC address, a 
hardware address that is not globally assigned by a manufacturer 
(OUI) but instead generated by the device or operating system

• Smart devices such as iOS and Android OS use a Private MAC 
address as the default.

• Private MAC addresses’ LG bit (Specifies if this is a locally 
administrated or globally unique (IEEE assigned) is true, 
that means the 7th bit of the first byte of the MAC Address is 1

• For example, Private MAC address starts with x2, x6, xA, xE, etc.

• We can filter Private MAC address as Display Filter Expression as 
eth.src.lg==1 in the Wired network
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Privete MAC Address in Wireless network

• If we want to filter the Private MAC Address in a Wireless network,
we can filter as Wireshark Display Filter syntax as
wlan.ta[0]&0x02==0x02
wlan.ta[0] means the first byte of the transmitter address
& means bit-based AND calculation
0x02 is the mask pattern matched for the 7th bit of the first byte

• Using tshark to filter the transmitter MAC address that is private

• Using cat, sort, uniq, and wc commands to count the private MAC
Private MAC STAs: 812, all STAs: 1344
so two-thirds(about 66%) of STAs are smart devices.

C: \Users\rnegurni \Desktop>tshark -T fields - e wlan. ta - r wi f isigint. pcapng - Y 11 wlan. ta[0] &0x02==0x02 11 >>private. txt 

C:\Users\rnegurni\Desktop>bash 
/mnt/c/Users/megumi/Desktop 

cat private.txt I sort I uniq I wc -l 
812 
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Try Display filter as “wlan.ta[0]&0x02==0x02”

• Two-thirds of the STAs are Private MAC addresses in the 
conference center

wifisigi nt.pcapng 

Fi'le Edit View Go Capture Analyze Statistics Telephony Wireless Tools He,lp 

[ 11 w1an.ta[0]&Ox02= =0x02 

No. Time PHY type CH f req. Signal MCS Rate Retry Type/ Subtype Source 

1 Probe Request a6:d0:9d:65:c8: 35 

(HE ) 
2 .. 2. 891000 802. llax (HE ) 40 5200MHz -77 dBm QoS Data f2:d5:65:11:cc:75 
2 .. 2. 891000 802. llax (HE ) 40 5200MHz -77 dBm QoS Data f2:d5:65:11:cc : 75 
2 .. 2. 891000 802. llax (HE ) 40 5200MHz -77 dBm QoS Data f2:d5:65:11:cc :75 
2 .. 2 . 892000 802. llax (HE ) 40 5200MHz -77 dBm QoS Data f 2: d5:65:11:cc:75 
2.. 2. 892000 802. llax (HE ) -77 QoS Data f 2 :d5:65:11:cc:75 

(OFDM) 
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□ X 

Im CJ ~ j + Manage men Control Frame~ Dat a,.. Signal Rate. Retry EAPOL AC.. 

Destination SSID BSSID STA 

Broadcast Broadcast 

TP Link_72 :a5:88 TPLink_7 .. f2:d .. 
TP Link_72 :a5:88 TPLink_7 .. f2:d . . 
TP Link 72:a5:88 TPLink 7 .. f2:d . . 
TP Link 72:a5:88 TPLink 7 .. f2:d .. 
TP Link 72:a5:88 TPLink 7 .. f 2: d . . 

6b :8d : 12 

Info 

Probe Request , SN•2048, FN-0, Fla 

P11ivate 

St ra nge 

Flags=op ..... T 
QoS Data, SN=3448, FN=0, Flags =op .. . .. T 
QoS Data, SN=3451, FN=0, Flags=op ..... T 
QoS Data, SN=3455, FN=0, Flags=op ..... T 
QoS Data, SN=3465, FN=0, Flags=op ..... T 
QoS Data, 



#sf25eu

Important hint of iOS’s Private MAC Address 

• iPhone and iPad use a Private MAC address by default,
iOS uses randomized MAC address in different locations.

• But iOS has interesting characteristics, iPhone and iPad use the 
same Private MAC address in the exact locations every time.

• That helps us identify the devices, for example, you watched 
some Private MAC address on Monday, and you find the same 
Private MAC address on Tuesday. The device is the same!!

•• •••• 
•••• 

-

•• 

v Tr ansmi t e r addr ess : e2 : ea : lb c::l d :45:f7 ( e 2 :ea: bc : 1d : 5:f7 ) 

.. , l . = L6 b • t : Locally admi ni ste r ed add r ess ( th is is 

. , ,.0 .. . ~ ,. . . . . ,., . . . . . = 16 bi.t : lflldiv i dual add ress. ( u • 1cas.·t ) 
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Common pattern of MAC address

• We experienced the interesting pattern 
of BSSID in the same AP.

• AP uses a sequential MAC address for 
different bands’ BSSID, for example
B0:BE:76:12:34:56 for 2.4GHz band
B0:BE:76:12:34:57 for 5GHz band
B0:BE:76:12:34:58 for 6GHz band

• Sometimes an AP uses multiple SSIDs
with similar BSSIDs
B0:BE:76:12:ab:cd for main SSID
B0:BE:76:12:ab:ce for guest SSID

• First 3 bytes are the same -> same OUI

• First 4 bytes are the same -> same AP

2.4GHz BSSID 

5GHz BSSID 

2.4GHz Guest BSSID 

5GHz Guest BSSID 

,Jir.rSSID(2.4GHz SSID) 

SSID: 

llitit: 

BSSID: 

lllllll;l,~ll: 

, Jir.rSSID(SGHz 551D) 

551D: 

85S1D : 

~;,.~SSID(Z 4GHz SSID) 

SSID : 

llitit: 

BSSID: 

~;,.~5S1D(SGHz SSIDl 

SSID : 

llitft: 

BSSID: 

0 

0 

0 

llititf.1:L, 

0 

0 

llltitf.l:L, 

0 

0 

llititf.l:L, 

0 



#sf25eu

Interesting MAC Address

• Sometimes an attacker uses interesting MAC addresses,
00:11:22:33:44:55 for debugging/testing 
DE:AD:BE:EF:00:00 for joking
AA:BB:CC:DD:EE:FF is the default value of the attack tool
00:00:00:00:00:00 is seen when the packet is broken
If you find these MAC addresses on your network, someone is 
measuring, attacking your WiFi, or packets are broken.

• For example, try display filter as wlan.ta in {00-00-00-00-00-00, 
11-22-33-44-55-66, de-ad-be-ef-00-00, aa-bb-cc-dd-ee-ff}

Sharkliest'25 c~ 
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[ 11 I wlan ta n {00 00 00 00 00 00 11 2, 33 44 55 66 de ad be ef 00 00} I - - -· - - - -- - - - - - - - - ' .... r I Im Cl y j + Manage men Cont ol Frame~ Dat il_ S gna~ Rat~ Retry EAPOL PWR 

No. Tiime PHY type CH Freq. Signal MCS Rate Ret ry Type/ Subtype Source Dest ination SS ID BSSID STA Info 

12-163.4880.. 802.lla (OFDH) 1- 5580MHz -66 dBm 6 Association Request 00:00:00 ·- 00:00:00.. 00:00:00.. Association Request, SN=3785, FN=0, Flags= ........ [Malforned Packet] 
2.. 64 . 2440 .. 802. lla (OFDH) 1 .. 5580r-liz -67 dBm 6 Association Request 00:00:00 ·- 00:00:00.. 00:00:00.. Association Request, SN=3799, FN=0, Flags= ........ [Malforned Packet] 
2.. 65 .4070 .. 802. lla (OFDH) 1 .. 5580r-liz -75 dBm 6 Association Request 00:00:00_ .. 00:00:00.. 00:00:00.. Association Request, SN=3445, FN=0, Flags= ........ [Malforned Packet] 
3 .. 66. 7310 .. 802.lla (OFDH) 1 .. 5580r-liz -76 dBm 6 Association Request 00:00:00_ .. 00:00:00.. 00:00:00.. Association Request, SN=3482, FN=0, Flags= ........ [Malforned Packet] 
3 .. 69.1370 .. 802.lla (OFDH) 1 .. 5580r-liz -63 dBm 6 As sociation Request 00:00:00_ .. 00:00:00.. 00:00:00.. Association Request, SN=3903, FN=0, Flags= ........ [Malforned Packet] 
3 .. 70.4610 .. 802.lla (OFDH) 1 .. 5580r-liz -63 dBm 6 Association Request 00:00:00 ·- 00:00:00.. 00:00:00.. Association Request, SN=3933, FN=0, Flags= ........ [Malforned Packet] 
4.. 71.8880 .. 802.lla (OFDH) 1 .. 5580r-liz -75 dBm 6 Association Request 00:00:00 ·- 00:00:00.. 00:00:00.. Association Request , SN=3562, FN=0, Flags= ...... .. [Malforned Packet] 
4.. 72.4130 .. 802. lla (OFDH) 1 .. 5580r-liz -74 dBm 6 As sociation Request 00:00:00_ .. 00:00:00.. 00:00:00.. Association Request, SN=3571, FN=0, Flags= ... . .... [Malforned Packet] 
4.. 73 .2350 .. 802.lla (OFDH) 1 .. 5580r-liz -67 dBm 6 Association Request 00:00:00_ .. 00:00:00.. 00:00:00.. Association Request, SN=3982, FN=0, Flags= ........ [Malforned Packet] 
5 .. 77 .0330 .. 802.lla (OFDH) 1 .. 5580r-liz -65 dBm 6 Association Request 00:00:00 ·- 00:00:00.. 00:00:00.. Association Request, SN=4047, FN=0, Flags= ........ [Malforned Packet] 
5 .. 77 . 5470 .. 802.lla (OFDH) 1 .. 5580r-liz -75 dBm 6 Association Request 00:00:00 ·- 00:00:00.. 00:00:00.. Association Request , SN=3676, FN=0, Flags= ... . .... [Malforned Packet] 
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Pick up the certain SSID

• The capture point is Ikeriri’s
booth at Hall 6

• Working Lounge is located at 
Hall 5, about 100 meters away 
from the capture point.

• Wireless -> WLAN traffic, sort 
the SSID column, and pick up 
“Hall5_Working_Lounge_Space” 
that BSSID is f4:d5:80:1d:01:e0 
and f4:d5:80:1d:01:e8

...... 

-

Wireshark , Wireless. LAN Statistics , wifisigintpcapng 

BSSID 

> f4:d 5:80: 1 d :01 ~eO 

> I f4:d 5:80: 1 d :01 ie8. 

Channel SS ID 

52 Hall5 _Wo:rk!iing_llou rnge_Spacie 

116 Hall5 Wo rk!i rng_ll ou nge Space 

Sharkliest'25 c~ 
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□ 

Percent Padloets Percent Retry Ret ry Beacions Data P'kts l iobe IR.e-qs ~robe Resp Auths Deaut hs Other Protection 

2.3 65.6 221 16 215 0 95 2 0 9 Unlm,own I ~"1-,~-----3-79 ____ 3_0 ___ 404 _____ 0 ____ 18_4 ____ 34 _____ 5 ____ 2_3_U_n_k_n_o_w_n __ 
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“Hall5_Working_Lounge_Space”

• Set Display Filter as wlan.bssid in {f4:d5:80:1d:01:e0, 
f4:d5:80:1d:01:e8} to filter “Hall5_Working_Lounge_Space” SSID

• This SSID is operated by two Yamaha APs, so pick up STAs as
wlan.bssid in {f4:d5:80:1d:01:e0, f4:d5:80:1d:01:e8} 
and !(wlan.ta.oui_resolved contains Yamaha)

• Let’s think about the Signal Strength of this SSID

Sharkliest'25 c~ 
EU~PE ~ 

,.: :::1 ~ 
~ - .__... ...,,. 

wifis1gmt.pcapng D X 

Fi le Ed"t View Go Capture Analyze Statistics Te ephony Wire ess Too s Help 

[ 11 w1a n.bssid in {f4:d 5:80: 1d:01:e0, f4:d5:80:1 d:01 :e8} l.:iCJ •] + Managemen Cont rol Fra me!i_. Dat ~ Signal Rate,. Ret ry EAPOL MAC.. 

2 ... 13. 7320. .. 8e2 .11a (O FOM) 52 5260MHz -77 d Bm 6 ✓ Pr obe Res pon se Ya maha l d:01 : e0 52: 94:49:96:c0:0e "Hal . . Yamaha L .. 

wifisigi nt.pcapng D X 

Fi'le Edit Viiev, Go Capture Analyze Statistics Te!ephony Wireles.s Tools He lp 

[ 11 w1a rn.bssid in {f4:d5:80:1d:01:e0, f4:d 5:80:1d:01 :e8} a nd !(wlan.ta .oui_resolved contains Yamaha) Im Cl • j + Managemen Control Fram e!i_. Dat i\,. Signal Rat e,. Retry EAPOL MAC.. 
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“Hall5_Working_Lounge_Space”

• We need to add a filter for the frames Type/Subtype is QoS Data,
set Display Filter as wlan.bssid in {f4:d5:80:1d:01:e0, 
f4:d5:80:1d:01:e8} and and wlan.fc.type_subtype ==40

• Sort the Signal Column descending, from strong to weak signal

• Strongest two packets’s Signal Strength(dBm) are -63dBm,
But the others start from -74dBm to -92dBm

• 100 meters away’s signal starts from -75dBm?
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wifisigint.pcapng D X 

File Edt View Go Capture Analyze Statistics Te ephony Wire ess Too s Help 

.£ ■ '®' ~ ~ ~ q $$ ~ {i? .fil. - ~~~ !! 6:il =:31! -

[ 11 wlan.bssid in {f4:d5:80:1d:01:e0, f4:d5:80:1d:01 :e8} and !(wlan.ta.oui resolved contains Yamaha) and wlan.fc.type subtype ==40 lmc •J + Management,, Control Frame$.. Dat'\. Signal Rat~ Retry EAPOL MAC. 
V 

I No. Time PHY type CH Freq. Signal MCS Rate Retry Type/ Subtype Source Destination SSID BSSID STA Info 

13369 48.4950.- 802.llax {HE) 116 5580r1-lz -63 dBm 8.600 .. QoS Data e2 :ea:bc:ld: 45:f7 IPv6mcast _fb Yamaha_L- e2:e_, QoS Data, SN=112, FN=0, Flags=op 
13368 48.4940.- 802.llax {HE ) 116 5580r1-lz -63 dBm 8.600- QoS Data e2:ea:bc:ld: 45: f7 IPv6mcast _fb Yamaha_L- e2: e_, QoS Data, SN=110, FN=0, Flags=op 
19952 59.5770,_ 802.llax {HE ) 116 5580r1-lz -74 dBm 8.100 .. ,/ QoS Data c2:85:4e :eb:41:38 Sony_99:65:99 Yamaha_L- c2:8_, QoS Data, SN=165, FN=0, Flags=op 
19960 59.5780._ 802.llax {HE ) 116 5580r1-lz -75 dBm 8.100- ,/ QoS Data c2:85:4e:eb: 41:38 Sony_99:65:99 Yamaha_L- c2:8_, QoS Data, SN=165, FN=0, Flags=op 

7161 28. 9390,_ 802. llax {HE ) 116 5580r1-lz -75 dBm 16 . 29 . . ,/ QoS Data c2:85:4e:eb:41: 38 Yamaha_L- c2:8_, QoS Data, SN=2766, FN=0, Flags=c 
4679 21 .0060._ 802.llax {HE ) 52 5260r1-lz -75 dBm 21.89_ QoS Data Intel 41:01:54 Sony_99:65:99 Yamaha L- Inte_, QoS Data, SN=861, FN=0, Flags=. p 
4678 21 . 0060,_ 802. llax {HE ) 52 5260r1-lz -75 dBm 21.89 .. QoS Data Int el_41:01: 54 5ony_99:65:99 Yamaha_L- Inte_, QoS Data, SN=859, FN=0, Flags=. p 
4677 21. 0060.- 802. llax {HE ) 52 5260r1-lz -75 dBm 21.89- QoS Data Intel_41 :01:54 Sony_99:65:99 Yamaha_L- Inte-, QoS Data, SN=857, FN=0, Flags= .p 
4676 21.0060.- 802.llax {HE ) 52 5260r1-lz -75 dBm 21.89- QoS Data Intel_41 :01:54 Sony_99 :65:99 Yamaha_L- Inte_, QoS Data, SN=855 , FN=0, Flags= .p 
2848 13.8780._ 802.llax {HE ) 52 5260r1-lz -76 dBm 21.89- QoS Data Intel_41 :01:54 Sony_99 :65:99 Yamaha_L_ Inte_, QoS Data, SN=412, FN=0, Flags= .p 

32384 67. 4540,_ 802. llax {HE ) 116 5580r1-lz -77 dBm 16 . 29 . . QoS Data c2:85:4e:eb:41:38 Sony_99:65:99 Yamaha_L- c2:8_, QoS Data, SN=3026, FN=0, Flags=c 
32329 67.4390._ 802.llax {HE ) 116 5580r1-lz -77 dBm 17 .20_ QoS Data c2:85:4e:eb:41 :38 Sony. 99:65:99 Yamaha L- c2: 8_, QoS Data, SN=3025, FN=0, Flags=c 
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RSSI investigation in WiFi SIGINT

• This trace is captured at a huge conference site, like a stadium,
A big open space, and many people visit the booth

• How about the office, the office floor is covered by many glass 
and gypsum board partitions. 

• These materials have different attenuation values (in dB) and 
reflection percentages of 2.4/5/6GHz signal

RSSI starts 
from -75dBm

• If we touch the wireless 
capture card with the devices, 
we get -30dBm in Japan (in 
Japanese radio law condition)

• Noise floor, the lowest signal 
is measured from -95dBm to
-105 dBm in usual
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Attenuation in dB and Reflection rate of 2.4/5GHz signal

• In general, attenuations and reflection rates of 2.4/5GHz signal

• These parameter helps us to determine the device is on site or 
off site, if you capture signals at -30dBm, the device locates in 
just a few meters away, if you captured at -31 to -50, the device 
may be in the same room, if you capture at -51 to -60, the device 
may locates in the same floor, if you capture at -61 to -79, the 
devices may be in the same building…

Materials 2.4GHz attenuation 5GHz attenuation Reflection Rate

Glass partition About 2-4dB About 3-6dB About 15-20%

Gypsum board About 3dB About 4-5dB About 3-5%

Metal Door About  16dB About 28dB About 100%

20cm concrete About 20-30dB About 25-45dB About 15-25%
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Signal threshold examples

• Usual threshold of WiFi RSSI(Receive Signal Strength Indicator)

RSSI(dBm) Location Details

From 0 to -30Bm Same room A few meters away

From -31 to -50dBm Same room
or next room

In the same room or next 
room divided with thin wall

From -51 to -60dBm Same floor or 
same building

In the same floor or same 
building of next floor

From -61 to -70dBm Same building Reflected signals from 2-3 
floors away

From -71 to -80dBm Same building 
or outside

Reflected signals from 
outside or concrete wall

From -81 to -90dBm Outside The lowest signal for data
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Create Display Filter button

• Edit -> Preferences and Choose Filter Buttons

• Let’s start a live demonstration
Part1: Collect WiFi scan packets with CommView for WiFi

Collect WiFi scan packets with Metageek Apps
Part2: Save and merge traces as a pcapng trace file

Start WiFi SIGINT analysis with Wireshark!!

Sharkliest'25 c~ 
EU~PE ~ 
~ M1 ~ ~ 

,U~ 

s ·g , •□ bmi a -e ro o a SI I ··( =- r di ta .db _ n signal - -
s ·g NJe . . d bfifi! a - I < =-3 nd ra , ioll:Q arntsi I > =-5 e FQQliWil a SI 

s·g e fl oor build ing .-d - I < =- 5 and ra iota al > =-r a ma SI 

s·g e buil - .db~ a - I <=- nd ra , ioil:Q alllltsi al I a SI --

s ·g C ll ' e bJ I Ou side . d bt1111 a - I <=- and ra ioil:Q al >=-a :SI 

s·g l. r/0 - .dbrnn a - I <=- nd ra , ioil:Q arntsi al SI e a SI --- _. 
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USE WIRESHARK

ikeriri network service

http://www.ikeriri.ne.jp

Thank you for your participation.

Please complete the survey 
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